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External Linkage Exercise
About the Data
Today’s external linkage exercise will involve linking a cancer registry data file with a vital statistics data file.  
Simulated Cancer Registry Records

The data file CCRV10.dat is a fixed width data file containing 50,000 simulated cancer registry records in the NAACCR (North American Association of Central Cancer Registries) Record Layout Version 10 format.  
Simulated Oregon 2005 Death Data

The data file ORVS2005.dat is a fixed width data file containing 10,000 simulated death certificate records in the same record layout as the 2005 Oregon Death data. 
Client Server (CS) File Source: Death_Daily  
Mainframe File Source: BH.DEATH.MONSTER.DAILY.YTD2005(0) 
Linkage Results

Ninety-nine death certificate records potentially match 99 individuals on the cancer registry data file, and are presented for manual review.  
Launching Link Plus & Beginning the External Linkage Exercise

To launch the Link Plus application and begin today’s exercise complete the following steps:

1. Close all other applications that you may have running.

2. Launch the Link Plus application by clicking on Start…All Programs…Registry Plus…Link Plus…Link Plus.

Result:  The main Link Plus window opens.
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3. Click on the File menu option, and select New Linkage.
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Result:  The Link Plus Linkage Configuration window opens.
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Review of External Linkage Steps

1. Select Data Type for File 1

2. Locate/Identify File 1

3. Data Import for File 1

4. Select Data Type for File 2

5. Locate/Identify File 2

6. Data Import for File 2

7. Select Blocking Variables & Phonetic System

8. Select Matching Variables & Matching Methods

9. Select ID Variables

10. Define Missing Values

11. Select Direct/EM Method

12. Enter Cut-off Value

13. Specify Linkage File Name and Location

14. Perform Manual Review of Uncertain Matches
15. Export Merged File

Step 1:  Select Data Type for File 1

Remember that File 1 and File 2 have a one to many relationship, with file 1 (ONE) and file 2 (MANY).  Because we would like each record for John Smith in the cancer registry file (CCRV10.dat) to have as many chances as possible to match a John Smith record in the external file (ORVS2005.dat), we will specify the External File, or ORVS2005.dat, as File 1.
To select the data type for File 1, leave the default value of fixed width selected in the Data Type drop-down menu for File 1.
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Step 2:  Locate/Identify File 1

To locate the ORVS2005.dat data file and identify it as File 1, complete the following steps:

1. Click on the folder icon to the right of the input box for File 1.
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Result: The Open Data File dialog box opens.
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2. Click on the ORVS2005.dat file, and click Open.

Result:  The Data Import Form for Fixed Width File opens.
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Step 3:  Data Import for File 1
To finish the data import process for File 1, complete these steps:
1. Place the cursor in the in the Data Item column of the first row of the record layout grid.

2. Using the Death 2005 record layout provided for today’s training, locate the start position and length of each of the variables in the below table, and complete the required information (shaded cells), using the Data Item Names provided.
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	The Blocking, Matching and Payload variables to be used for today’s exercise are highlighted in green on the Death 2005 layout.


The required Start Position and Length are provided for the death certificate number and date of birth variables, due to the concatenation of multiple fields. 

	 Variable
	Data Item Names
	Start Position
	Length

	Year of Death
	DTHYR
	
	

	Death Certificate Number
	DCERT
	3
	5

	Decedent’s Last Name
	LNAME
	
	

	Decedent’s First Name
	FNAME
	
	

	Decedent’s Middle Initial
	MI
	
	

	Month of Death
	DMM
	
	

	Day of Death
	DDD
	
	

	Race
	RACE
	
	

	Sex
	SEX
	
	

	Birth date
	DOB
	93
	8

	SSN
	SSN
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	Additional Matching and Payload variables that you may want to use in future linkages are highlighted in blue on the Death 2005 layout.


3. Enter the required information into the record layout grid, and click on View Data.
Result:  Link Plus displays the first 20 lines of data in the file, so you can ascertain whether you have the proper positions and lengths for the variables. 
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4. Make sure everything is aligned properly, and then click OK.
Result:  The Save Record Layout File dialog box opens.
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5. In the File name box, enter ORVS2005.txt, and click Save.
Result: The ORVS2005 record layout is saved, and the application returns you to the Linkage Configuration window.
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Step 4:  Select Data Type for File 2
To select the data type for File 2, leave the default value of fixed width selected in the Data Type drop-down menu for File 2.
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Step 5:  Locate/Identify File 2

To locate the CCRV10.dat data file and identify it as File 2, complete the following steps:

1. Click on the folder icon to the right of the input box for File 2.
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Result: The Open Data File dialog box opens.
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2. Click on the CCRV10.dat file, and click Open.

Result:  The Data Import Form for Fixed Width File opens.
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Step 6:  Data Import for File 2

To finish the data import process for File 2, complete these steps:

1. Click on the folder icon to the right of the Record Layout box.

Result:  The Open Record Layout File dialog box opens.
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2. Click on the NAACCR10DEFAULT.txt record layout.

Result:  The NAACCR10DEFAULT.txt record layout is selected into the File name box.
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3. Click on Open.
Result:  You are returned to the Data Import Form for Fixed Width File window, with the NAACCR Version 10 record layout entered automatically in the record layout grid.
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4. Click on View Data.
Result:  Link Plus displays the first 20 lines of data in the file in the NAACCR Version 10 record layout, so you can verify you have the proper positions and lengths for the variables. 
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5. Click OK.
Result: The ORVS2005 record layout is saved, and the application returns you to the Linkage Configuration window.

[image: image20.png]Fle_Manual Review Dzt _Help

=181]

@[d[#ADE[E[v]= [

Fixed Widih
Data Type:

=] Filel [CiRegPus\LinkPlus\data\ORVS2005 dat

Fixed Width

Select blocking variables

=] File2 [CiRegPlusiLinkPlus\data\CCRV10 dat

Select ID variables (File 1)

Data ltem (File 1)

Data ltem (File 2)

Phanetic System

Select matching variables and methods

Data ltem (File 1)

Data ltem (File 2)

Matching Methad

Missing Value (File 1)

Add Remove
[lease set the parameters and

Add Remove
then click the Run button

[ Missing Value (File 2) ——— & Direct Method

Select ID variables (File 2)

Advanced

Save
Cutaff Value:
Results will be saved to =] Cancel
[CiRegPlus\LinkPlusireportiLinkageReport bt Rurt
L |

start| | )ik Plus Traning .. | [3] Mcrosoft PowerPoi... | & 2 intemet Explorer_+| (5 CikkiLinkPlus

[t tink pius - ftinka. box - Mirosoft O... | [« 2@ 10553 am




Step 7:  Select Blocking Variables & Phonetic System
To select blocking variables and a phonetic system (where applicable), complete these steps:

1. Click on the first empty cell of the grid in the Select blocking variables section.
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Result:  A drop-down menu appears. When clicked, this menu contains all of the variable names of the variables to be imported for File 1 (ORVS2005.dat).
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2. Using the drop-down menus for each of the three columns, make the following selections for blocking variables and phonetic systems:

	Data Item (File 1)
	Data Item (File 2)
	Phonetic System

	DOB 
	Birth Date
	

	LNAME 
	Name--Last
	Soundex

	SSN
	Social Security Number
	


Step 8:  Select Matching Variables & Matching Methods
To select matching variables and their respective matching methods, complete these steps:

1. Click on the first empty cell of the grid in the Select matching variables and methods section.

[image: image23.png]Fle Manual Review Dzt Help

=181]

[ = B

Data Type:

Fixed Width ~| Filel: [Ci\RegPlus\LinkPlus\data\ORVS2005 dat

Select blocking variables

Fixed Width | File2  [CiRegPlusiLinkPlus\data\CCRV10 dat

Select ID variables (File 1)

Select matching variables and methods

Data fom (Fle 1) Data fom (Fl 2) Phonetic System ii
o8 Birth Date

| Lnave Name--Last Soundex

RS Name--First Soundex

Select ID variables (File 2)

Data ltem (File 1) Data ltem (File 2)

Matching Methad

[ Missing Value (File 1) Missing Viaue (File 2)

Add Remove Add Remove

¥ Direct Method

Advanced

Save
Cutaff Value:
Results will be saved to =] Cancel
[CiRegPlus\LinkPlusireportiLinkageReport bt T
L |

[Please set the parameters and then click the Run button

Astart| | [#]5 Microsoft ... | [ Link Plus - [Lin.. )2 Windows Ex... -] [ FLAC frontend

[ ) tenat e, | @ voro s

| [ picrosoft power... | [« 2, 11:336m




Result:  A drop-down menu appears. When clicked, this menu contains all of the variable names of the variables to be imported for File 1 (ORVS2005.dat). 
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2. Using the drop-down menus for each of the three columns, make the following selections for matching variables and matching methods:

	Data Item (File 1)
	Data Item (File 2)
	Matching Method

	DOB 
	Birth Date
	Date

	LNAME 
	Name--Last
	Last Name

	FNAME
	Name--First
	First Name

	SSN
	Social Security Number
	SSN

	MI
	Name--Middle
	Middle Name


Step 9:  Define Missing Values
Link Plus automatically treats null or empty values as missing data for Matching Variables and allows the user to indicate additional values which are to be treated as missing data by the program.

To define missing values for the matching variables selected, complete these steps:

1. Select the Birth date matching variable Variable common to the two files that is used for comparing records by clicking on its row in the matching variables grid.

Result:  The missing values and format grid for dates appears.
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Entering missing values for date variables works a little differently from other variables.  Missing values are specified separately for each of the date components; day, month, and year.
2. Enter the missing values in the following table:
	Date Component
	Missing Value (File 1)
	Missing Value (File 2)

	Day
	99
	99

	Month
	99
	99

	Year
	9999
	9999


3. In addition to specifying missing values separately for each of the date components, the date format must also be specified.  
Link Plus accepts two date formats, MMDDYYYY, and YYYYMMDD.  The Oregon 2005 Death file has the birth date in the YYYYMMDD format, while the cancer registry file (in the NAACCR record layout) uses the MMDDYYYY date format.  
Use the pull-down menu in the format row of the grid to select YYYYMMDD for File 1 and MMDDYYYY for File 2.
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4. Select the last name matching variable Variable common to the two files that is used for comparing records by clicking on its row in the matching variables grid.
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5. Click the Add button in the Missing Values grid for File 1.
Result: A cell opens where you can enter a missing value for the last name variable.
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6. Type UNKNOWN in the cell, and click Add. 
7. Type UNK in the new cell that appears.

8. Click the Add button in the Missing Values grid for File 2 at the bottom of the screen.

9. Type UNKNOWN in the cell, and click Add.

10. Type UNK in the new cell that appears.

11. Select the first name matching variable Variable common to the two files that is used for comparing records by clicking on its row in the matching variables grid, and repeat steps 5-12.

12. Select the Social Security Number matching variable Variable common to the two files that is used for comparing records by clicking on its row in the matching variables grid.

13. Click the Add button in the Missing Values grid for File 1.

14. Type 999999999 in the cell and click Add.  Type 000000000 in the new cell that appears.

15. Click the Add button in the Missing Values grid for File 2 at the bottom of the screen.

16. Type 999999999 in the cell and click Add.  Type 000000000 in the new cell that appears.
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	You can add up to 5 Missing Values.  Missing Values can be deleted by clicking the Remove button.


Step 10:  Select ID Variables
Although Link Plus reports will automatically include Matching Variables, you may want to define other variables to be included in the reports, called ID Variables.  ID Variables, such as Patient ID Number and Record #, are variables used for identifying records. Selection of ID Variables is optional.  

To select ID Variables for File 1 and 2 complete these steps:

1. Click in the Select ID variables (File 1) grid, and select the DCERT variable from the drop-down list that appears.
[image: image30.png]=181 x|

Fle Manual Review Dzt Help

[ = B

Fixed Widih =] Filel  [CiRegPlus\LinkPlus\data\ORVS2005 dat
Data Type:
Fixed Widih =] Fie2  [CiRegPls\LinkPlus\datz\CCRY10 dat
Select blocking variables Select ID variables (File 1)
Data Item (File 1) Data ltem (File 2) Phonetic Systern ii B j‘
DOB Birth Date DTHVR =
T -
[ LNavE Name-Last Soundex v
FNAME Name-First Soundex FNAME
T MI
Select matching variahles and methods DMM
[Blala}
Data ltem (File 1) Data ltem (File 2) Matching Methad RACE &
| Doe Birth Date Date
| LnavE Name-Last Last Name
FNAME Name-First First Narme
EE Social Security Nurmber SSN
Y Narne--Middle Middle Name
Missing Value (File 1) [ Missing Viaue (File 2) | @ Direct Method
959999959 959999959
Cutoff Val
000000000 000000000 ot valus
Results will be saved to =]
[CRegPlus\LinkPlusireportiLinkageReport bt Run
| L]
Add Remove Add Remove
[To know how to select ID variahles, please click on the help icon in the tool bar

Bstart] | [#]5 mcrosoft ... ~|[{58 Uik Plus - Timr, | 232 Windows Ex... <| Bl FLaCrontend | &) inemet archive... | @ Neroxpress | [& marosoftpower.. | [« i 1oz am





2. Click in the Select ID variables (File 2) grid, and select the Patient ID Number variable from the drop-down list that appears.
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Step 11:  Select Direct/EM Method
For the purposes of today’s exercise, we will be using the Direct Method to derive the M-Probabilities used in the linkage.  The M-Probability is the probability that a matching variable agrees given that a comparison pair is a match.  When the Direct Method box is clicked, default M-Probabilities are used in the linkage.  Leave the Direct Method box clicked.
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	You can click on Advanced to view the default M-Probabilities or define your own.
Un-click the Direct Method box if you prefer Link Plus to compute the M-Probabilities based on your data using the EM algorithm


Step 12:  Enter Cut-off Value
Remember that the Cut Off Value is the score value above which comparison pairs are accepted as potential links and presented for manual review.  For the purposes of today’s exercise, enter an initial Cut Off Value of 7 in the Cutoff Value box. 
                                              
[image: image34] 

Step 13:  Specify Linkage File Name and Location
At the completion of a linkage run, Link Plus will generate a Linkage Report, named LinkageReport.txt, and store it in the Report folder of the Link Plus directory.  The report is a tab delimited text file, and can be opened with a text editor or a spreadsheet program.  Link Plus also generates a non-match report, named Non_MatchReport.txt, which contains records from File 2 (cancer registry file) not matched to records in File 1 (Oregon 2005 Death file).
The report header lists the files that were used and all of the parameters that were set for the run. Below the header is the report detail.  Records are presented in comparison pairs sorted by their linkage scores, in descending order.  Pairs with scores above the selected cut off value are listed. The detail row for each record contains all of the matching and ID variables Variables used for identifying records such as patient ID and record ID. used in the linkage.

If you want to save the report, you need to rename it or it will be over-written the next time you run Link Plus. 

To rename the Linkage Report, complete these steps:
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 to the right of Results will be saved to.
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Result:  The Save linkage results to the file below dialog box opens.
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2. Enter ExternalLink.txt in the File name box, and click Save.
Result: The application returns you to the Linkage Configuration window, where the linkage report name has been changed to ExternalLink.txt.
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3. Click on Save to save the configuration file for this external linkage exercise.
Result: The Save Configuration dialog box opens.
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4. Enter ExternalLink.cfg in the File name box, and click Save.
5. Click Run to run the linkage.
Result:  The linkage is run, and Link Plus generates a Linkage Report named ExternalLink.txt, which is automatically opened within Notepad.
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LNAME 0.97000 0.00091 6.34880 -3.19098 Iast name
FNAME 0.96000 0.00367 5.06637 -2.92660 first name
SSN 0.98000 0.00010 8.36504 -3.56079 SSN
MI 0.97000 0.04850 2.72682 -3.14655 middle name

m-prob: The probability that a matching variable agrees given that the comparison pair being examined is a match
u-prob: The probability that a matching variable agrees given that comparison pair being examined as a non-match
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disagree: The disagreement weight assigned for a disagreement on a given matching variable
matching method: The method used for computing the weight on a given matching variable.
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6. Close this window. 
Result: Link Plus returns to the Linkage Configuration screen, with a message issued in green along the bottom of the screen, indicating that the linkage is complete.
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Step 14:  Perform Manual Review of Uncertain Matches
To conduct manual review of the potential matches generated by the external linkage that was just performed, first open the ExternalLink.txt linkage report in a new view, select additional fields for manual review, and then perform the manual review, assigning a match status to each potential match.

To open the linkage report and select additional variables for manual review, complete these steps:
1. On the Linkage Configuration screen, click on the Manual Review menu item, and click on the New View… option. 
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Result:  The Select Linkage Report for Manual Review dialog box opens.

[image: image43.png]=18l

Fle. Manual Review Data_Felp
= Bl
2lx
Lock in: [ 5 Report - - E®EekE-
[Elecermatriccc] 100t

LinkageReport.txt
) Mon_MatehRepart bt

2005 dat

Select ID variables (File 1)
System ﬂ ©  DCERT

Select ID variables (File 2)

= Patient ID Number
Method

e [Enemaore I |
T e 4w

I~ Open as eadorly

ame

4

Advanced

[ Missing Value (File 1) Missing Value (File 2) | ¥ Direct Method -
ave
Cutoff Value: 7
Results will be saved to =] Cancel
[CRegPlus\LinkPlus\Report\ExternalLink bt R
L |

Add Remove Add Remove
[Please set the parameters and then click the Run button

9 start| | 5] Link Plus Training Linkage... | | Microsaft PowerPaint - L. | £ Yahoa Mai - Kkthoburn... | g Link Pus - [Linkage Carfi « R 1msan





2. Select the ExternalLink.txt linkage report, and click Open.
Result: The Select Additional Fields for Manual Review dialog box opens.
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When performing manual review of potential matches, if you would like to view additional fields other than those already chosen for blocking, matching and ID purposes for the linkage, you can check the boxes on the left and/or right grids for the fields you would like to view. Fields added in this manner will be shown on separate columns on the manual review screen.
3. Click on the boxes to the left of the DTHYR, DMM, and DDD field names in the Add fields in File 1 grid.
Result:  These three fields get added to the center list of Fields for Manual Review, with a _File1 after the field name to indicate that these fields come from File 1.
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However, if you would like two fields, one from file 1, another from file 2, to display on the same column on the manual review screen, you would go to the bottom grid in the center of the page and click on the cells to bring up drop-down lists of fields on the files to select the fields. 
4. In the center panel, in the Field Name (File 1) grid, click in the first empty cell.

Result:  A pull-down menu appears.

5. Select SEX from the pull-down menu.
6. In the center panel, in the Field Name (File 2) grid, click in the first empty cell.

Result:  A pull-down menu appears.

7. Select Sex from the pull-down menu.
8. In the center panel, in the Field Name (File 1) grid, click in the second row of the grid and select RACE from the pull-down menu.
9. In the center panel, in the Field Name (File 2) grid, click in the second row of the grid and select Race1 from the pull-down menu.
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10. Click on the [image: image47.png]


 button above the grids.

Result:  The fields of sex and race are added for manual review with the fields from each file to be displayed on the same column for each potential match.
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You can also change the order of fields on the manual review list by clicking on a field and using the small up-arrow and down-arrow to move the field up or down in order.  This is the order in which the columns will be presented for manual review. 
11. Select the DCERT_File1 field on the Fields for manual review list, and click on the down button until the DCERT_File1 field is the last field on the list.
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12. Select the Patient ID Number_File2 field on the Fields for manual review list, and click on the down button until the Patient ID Number_File2 field is the last field on the list.

13. Select the DOB; Birth Date fields on the Fields for manual review list, and click on the down button until DOB;Birth Date fields are located after the FNAME; Name—First fields.
14. Select and reposition the SEX;Sex and RACE;Race1 fields on the Fields for manual review list so that they are located after the MI; Name—Middle fields.
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15. Click OK.
Result: The manual review screen opens for the ExternalLink.txt linkage report, with the fields and columns ordered as you specified. 
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Manual Review Screen Menu Items
From the main Manual Review screen, you can access the main menu items for the Link Plus manual review process. Click on a menu item option to perform the specified function for the option. The below table describes the menu options on the main Manual Review Screen:

	Menu Item
	Sub-option
	Tool Bar Icon
	Function 

	Manual Review
	New View…
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LI =EIRRS
1 = true matches lse matches [] = uncertain matches = unmatched values = missing values,
Score |Class |Linkage ID | Set ID = |Record # | Patient ID Number |Name-First _|Name-Last _|Name-Middle |Race 1 |Sex |Birth Date| a
1 461 99098 90000600 BENTO  DEVRES W 02 1 13080601 El
[ 330 6 1 461 99180 90000682 BENTO  DEVRES W 02 1 19080601
2 460 99027 90000529 GINA MCELROYS ~ KEYS 02 2 19190410
[ 330 5 2 460 99129 90000631 GINA MCELROYS  KEYS 02 2 19190410
3 459 99043 90000550 JAMARCUS RUDACILLE ~ Z ©2 1 e
[ 328 6 3 459 99148 90000650 JAMARCUS RUDACILLE ~ Z ©2 1 e
4 458 99029 90000531 DARRON ~ DOWDELL ~ NOLAND 02 1 19520425
o327 5 4 458 99131 90000633 DARRON  DOWDELL  NOLAND 02 1 19520425
5 457 99043 90000545 MARIA DEARDEN ~ MARIORE 01 2 19260515
L1323 6 5 457 99143 90000645 MARIA DEARDEN ~ MARIORE 01 2 19260515
6 456 99095 90000598 WAYLAND  DOPSON 9 1 19000306
316 5 6 456 99181 90000683 WAYLAND  DOPSON 9 1 19000306
7 455 99095 90000597 JAKOB BUSHONG B o1 en2r
L1316 6 7 455 99174 90000676 JAKOB BUSHONG B o1 wn2r
8 454 99025 90000527 TYRONE ~ WINFREY ~ ETCHINSON 01 1 1927019
315 6 8 45499127 90000629 TYRONE  WINFREY  ETCHINSON 01 1 19270519
9 453 99036 90000538 FORREST  LANKFORD o 1 19780105
L1314 6 9 453 99136 90000638 FORREST  LANKFORD o 1 19780105
10 452 99082 90000584 ESTER HIPP MAGDALENA 01 2 19561005
314 5 10 452 99187 90000689 ESTER HIPP MAGDALENA 01 2 19561005
1 451 99018 90000520 ZELA WHITTINGTON SCHABLE 01 2 13220201
L1313 6 1 451 99120 90000622 ZELA WHITTINGTON SCHABLE 01 2 13220201
12 450 99067 90000569 BEULAH  LANCON T 01 2 19390614
313 5 12 450 99167 90000669 BEULAH  LANCON T 01 2 19390614
13 449 90000875 MELONE ~ PURPLE CHAVIS 0 2 9T
L1312 6 13 449 90000696 MELONE ~ PURPLE  CHAVIS 0 2 9T
i 448 90000572 NELLA SUTTIE EUNICE 01 2 19720509
312 5 1 448 90000672 NELLA SUTTIE EUNICE 01 2 19720509
15 447 90000517 ORAL HAWS NOONKESTEF 01 1 19930306
L1312 6 15 a7 90000619 ORAL HAWS NOONKESTEF 01 1 19930306
% 446 90000543 STACY MAYS BRITTEN 01 2 19630804
[ 311 5 16 445 90000643 STACY MAYS BRITTEN 01 2 19630804
7 415 20000526 NONOVAN  HUTGH 20 1wt





	Create a view from a linkage report

	
	Open View…
	
	Open an existing view

	
	Double View…
	
	Create a view from two views to resolve the differences in assigned match statuses

	
	Restore View
	[image: image54.png]kplus\VbDemo\report\workingview. default]

LI =EIRRS
1 = true matches lse matches [] = uncertain matches = unmatched values = missing values,
Score |Class |Linkage ID | Set ID = |Record # | Patient ID Number |Name-First _|Name-Last _|Name-Middle |Race 1 |Sex |Birth Date| a
1 461 99098 90000600 BENTO  DEVRES W 02 1 13080601 El
[ 330 6 1 461 99180 90000682 BENTO  DEVRES W 02 1 19080601
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	Open the most recent view

	
	Save View
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	Save the current view

	
	Save View As…
	
	Save the current view under a new name

	
	Close View…
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	Close the view

	
	Options…
	
	Manual Review Tab - Set color scheme for main manual review screen

Export Tab - Specify delimiter for export of delimited merged file

Data Link Tab – Under construction

	Data
	Pair View…
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	View the current comparison pair in Pair View mode rather than Datasheet mode

	
	Assign Match Status…
	
	Assign match status based on score

	
	Display All
	
	Display all pairs for review regardless of match status

	
	Display Uncertain Match Only
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	Hide all pairs that have been assigned a match status of true or false, displaying only uncertain matches for review

	
	Definition of “Class”…
	
	Open the form where coding of the “class” category can be modified

	
	Summary…
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	Display summary information regarding the total number of true matches, false matches, and uncertain matches for the current review session

	
	Hide-Unhide/Column-Reorder
	
	Hide and unhide columns and change the order of columns

	
	Find
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	Find a word within a column

	
	Reassign Set ID
	
	Reassign Set ID - for deduplication linkages only - Set ID is an unique number assigned to each group of duplicated records and may be manually reassigned

	
	Export
	
	Open the merged file export dialog box

	Help
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	Open Link Plus online Help


The Datasheet View
For the manual review of uncertain matches, the default view for comparison pairs is the Datasheet View, where comparison pairs are sorted together and displayed in alternating rows of white and gray colored background.  For each comparison pair, in addition to the variables chosen for matching and manual review, Link Plus generates the following:

	Score/Identifier
	Description

	Score
	For a comparison pair, the overall weight over all matching variables; a higher score means a higher likelihood of being a match

	Class
	Each comparison pair is assigned to a “class” category, which is defined by which matching variables the pair matches exactly on; e.g., Class 1 by default is defined by a perfect match on SSN, Birth Date, First and Last Names
Class category definitions may be customized by the user

	Link ID
	Unique number assigned to each linked pair

	File
	For a comparison pair, the File number identifies which file (File 1 or File 2 ) the record in the comparison pair originated from 

	Set ID
	For deduplication linkages only - Set ID is a unique number assigned to each group of duplicated records because a record may have multiple duplicates

	Record #
	Record # is the sequential line (row) number for a record in its data file; e.g., the Record # of the record in the first line of a data file is 1


Definition of Class

Link Plus assigns each comparison pair to a “class” category, which is defined by which of the matching variables of SSN, Birth Date, First and Last Names that the pair matches exactly on.  For example, Class 1 by default is defined by a perfect match on SSN, Birth Date, First and Last Names.  You may want to sort on Class to sequentially work on groups of similarly matching comparison pairs.
Class category definitions may be viewed and customized by the user.  To view or modify Class definitions, complete these steps:

1. Click on Data from the main menu, and then click on Definition of “Class”…
Result: The Coding for Class dialog box opens.
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2. View the definitions and/or modify them using the Y, N, X, and XN coding convention shown.

Within comparison pairs, the record from File 1 is listed first, and the column headers for the variables selected for matching are displayed in a File 1;File 2 format.  In addition, unmatched and missing values for matching variables are highlighted in pink and yellow, respectively.  
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Sorting, Hiding, Re-Ordering, Re-Sizing and Re-Formatting Columns 

The Datasheet View is highly customizable. While working in manual review, individual columns may be sorted, hidden/unhidden from view, and re-sized.  In addition, the order of the columns on the review screen may be modified at any time. 

Sorting Columns

To sort the data within the datasheet view by any individual column, simply click on the column header.  The first click will sort the data in ascending order, and the second click will sort the data in descending order. 
Try this with the Score column, clicking it once to sort the data by scores in ascending order, a second time to sort the data by scores in descending order, and a third time to return them back to being sorted in ascending order. 
Hide-Unhide/Reorder Columns 

To hide, unhide or re-order columns within the datasheet view complete these steps:

1. Click on the Data menu item and select the Hide-Unhide/Column-reorder option.

Result: The Hide-Unhide/Reorder Columns dialog box opens.
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Hide-Unhide/Reorder Columns dialog box contains two main sections, the Hidden box and the Displayed box.  The Hidden box lists the columns you have selected to hide from view, while the Displayed box lists those that you have selected to view.

The Hide-Unhide/Reorder Columns dialog box enables you to control which columns are displayed for manual review by using the Left and/or Right arrow buttons between the Hidden and Displayed list boxes to move columns between the two lists. 
	[image: image65.png]



	A column may also be hidden from view by right-clicking on the column, and selecting the Hide Column option.


The dialog box also enables you to change the order of the displayed columns.  Select the column name from the list in the Displayed box and use the Up and/or Down arrow buttons to the right of the Displayed list box to move the column up or down in order. 
2. Click on Record #, and then click the left arrow button.
Result:  The Record # column is moved to the list of hidden columns.
3. Click OK.

Result:  Link Plus returns to the main manual review screen, with the Record # column hidden from view.
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Re-sizing Columns

To re-size any column on the Datasheet View, left-click and hold on the divider between any two column headers, and pull to the right or left to change the column width. 

Re-formatting Columns

Link Plus allows the user to re-format columns containing dates, phone numbers, Zip code +4 codes, or social security numbers. 
	Format
	Description

	Date (mm/dd/yyyy)
	Re-formats the data in the selected column to MM/DD/YYYY 

	Date (yyyy/mm/dd)
	Re-formats the data in the selected column to YYYY/MM/DD 

	Phone Number
	Re-formats the data in the selected column to (###)###-####

	Zip Code +4
	Re-formats the data in the selected column to #####-####

	Social Security Number
	Re-formats the data in the selected column to ###-##-####


1. Right-click on the SSN;Social Security Number column, select Format, and then select the Social Security Number format. 
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|Score | Class |Link ID |File |Record # | LNAME; Name-La| FNAME; Name-Fi| DOB;Birth Dat | SSN;Social Security Nun| Mi;Name-Middl| SEX,Sex|RACE;Race 1|DTH: 4|

FE TR ) BARTON LORA 0821948 B0BB25247 3 > 1 0
[1210 4 14 2 11512 BARTON LORA ommoss  onsazs2e7 Y Dt (riclyyyy)

4 15 1 @™ CHESNUTT CLFTON 08271950 BO4R25A7)  Restors OrnalFomat - Date (yyyyinmidd) [
[I210 4 15 2 14502 CHESNUTT  CLIFTON G710 BT o™ e e

4 8 1 =@ MOURER BRUCE 09151940 922530012 —o e o
[1210 4 16 2 24502 MOURER BRUCE 09151940 922530012 N

4 7 1 = KALTHOFF CHRISTNE ~ 0B151903 26727261 i 2 2 o
[1208 4 17 2 26002 KALTHOFF CHRISTNE ~ 0G151903 25727261 | 2 2

4 | 1 B WAITS ROBIN o031935  B0BE25E21 s 2 1 o
[I208 4 18 2 17502 WATS ROBIN Oo031935  B0GE25E21 s 2 1

4 19 1 = MARSHALL  TIFFANY 0E251948  BOED25244 c 2 1 o
[1207 4 13 2 11002 MARSHALL  TIFFANY 0E251948  BUE25244 c 2 1

4w 1 3 600D IMMY 9261944 099528509 H 1 1 o
[1207 4 20 2 16502 GOOD MY 09261944 099528509 HEDEMAN 1 1

42 1 s REEVES BERTHA O011933  BE5529060 G 2 2 o
[l207 4 20 2 2002 REEVES BERTHA O011933  BB5529060 G 2 2

42 1 e LECOMPTE  NICHOLAS 0201918 3426965 E 1 1 o
[1206 4 22 2 20502 LECOMPTE  NICHOLAS 0201918 3426965 EMERSON 1 1

4 @ 1 5% CLETT MARIE 0490 97T % 2 1 o
[l205 4 23 2 27002 CLETT MARIE 492 92T w 2 1

424 1 B MORRIS SHERRIE 0927193 90BA2839 L 2 0 o
[I204 4 24 2 12502 MORRIS SHERRIE 0927193 908528309 LoLa 2 0

4 ® 1 8 VASSALLO  KATHLEEN 12151930 854129526 w 2 1 o
[1204 4 25 2 40002 VASSALLO  KATHLEEN 12151930 854129626 w 2 1

4w 1 84 STEWART NICOLA 0221971 BEBO29801 [ 2 1 o
[1204 4 265 2 41502 STEWART NICOLA 09221971 85029801 DORTHY 2 1

4 7 13 HIGGINS FRANCES 0201924 0425513 G 2 1 o
[l204 4 27 2 15002 HGGINS FRANCES 02194 0425513 GOMEZ 2 1

4 |\ 1 9 BISHOP PETER 08311935 B0BO28771 z 1 1 o
[1203 4 28 2 46002 BISHOP PETER 08311935 B0BO28771 z 1 1

4/ 17 GOYETTE VICTOR 04111935 B0BA27656 7 1 0 o
[l22 4 28 2 3002 GOYETTE VICTOR 04111935 B0BS27656 TMOTHY 1 0
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Result:  The data is the column is re-formatted to the specified format.
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|Score | Class |Link ID |File |Record # | LNAME; Name-La| FNAME; Name-Fi| DOB;Birth Dat | SSN;Social Security Nun| Mi;Name-Middl| SEX,Sex|RACE;Race 1|DTH: 4|

FE TR ) BARTON LORA 0281948 B0B-626247 F 2 T [
[1210 4 14 2 11502 BARTON LORA 06281945 805825247 FRANCE 2 1

4 15 1 @™ CHESNUTT CLFTON 08271950 804825470 M 1 1 [
[1210 4 15 2 14502 CHESNUTT CLIFTON 08271950 804825470 MCGOUGH 1 1

4 B 1| MOURER BRUCE 09151940 922530012 N 1 1 w
[1210 4 16 2 24502 MOURER BRUCE 09151940 922530012 N 1 1

4 17 1 os KALTHOFF CHRISTINE OB151909 825727261 i 2 2 [
[1208 4 17 2 26002  KALTHOFF CHRISTINE OB151909 825727261 i 2 2

4 1B 1 W WAITS ROBIN 09031935 BDB625621 s 2 1 [
[1208 4 18 2 17502 WAIS ROBIN 09031935 BDB625821 s 2 1

4 18 1= MARSHALL  TIFFANY 0B251948 808225244 € 2 1 [
[1207 4 19 2 11002 MARSHALL  TIFFANY B251948 808225244 € 2 1

4! 1w GOOD MY 09261944 899528509 H 1 1 [
[1207 4 20 2 16502 GOOD JMMY 09261944 899528508 HEIDEMAN 1 1

42 1 B REEVES BERTHA 09011933 865-52.9060 6 2 2 [
[1207 4 21 2 3002 REEVES BERTHA 09011933 865-52.9060 6 2 2

402 1@ LECOMPTE  NICHOLAS 0B201918 634826965 E 1 1 [
[1206 4 22 2 20502 LECOMPTE  NICHOLAS 0B201918 634826965 EMERSON 1 1

4 0\ 1 s CLETT MARIE 08241922 904229717 w 2 1 [
[J205 4 23 2 27002 CLETT MARIE 08241922 904-22.9717 w 2 1

4 224 1B MORRIS SHERRIE 0927193 908528389 L 2 0 [
[1204 4 24 2 12502 MORRIS SHERRIE 0927193 908528389 LoLa 2 0

4 B 18 VASSALLO KATHLEEN 12151930 854129526 w 2 1 [
[1204 4 25 2 40002 VASSALLO KATHLEEN 12151930 854129526 w 2 1

4 B 1w STEWART NICOLA 09221971 858-02.9801 D 2 1 [
[1204 4 265 2 41502  STEWART NICOLA 09221971 858-02.9801 DORTHY 2 1

47 13 HIGGINS FRANCES 03211924 804625513 6 2 1 [
[l204 4 27 2 15002 HGGINS FRANCES 03211924 804625513 GOMEZ 2 1

4 0B’ 1@\ BISHOP PETER 08311935 BOB026771 I 1 1 [
[1203 4 28 2 46002 BISHOP PETER 08311935 BOB026771 I 1 1

4 2w 17 GOYETTE VICTOR 04111935 808527656 T 1 0 [
[J202 4 2 2 3002 GOYETTE VICTOR 04111935 808527656 TMOTHY 1 i
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2. To restore the data to its original format, right-click on the SSN;Social Security Number column, and select Restore Original Format.
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4 17 1 os KALTHOFF CHRISTINE OB151909 825727261 i 2 2 [
[1208 4 17 2 26002  KALTHOFF CHRISTINE OB151909 825727261 i 2 2

4 1B 1 W WAITS ROBIN 09031935 BDB625621 s 2 1 [
[1208 4 18 2 17502 WAIS ROBIN 09031935 BDB625821 s 2 1

4 18 1= MARSHALL  TIFFANY 0B251948 808225244 € 2 1 [
[1207 4 19 2 11002 MARSHALL  TIFFANY B251948 808225244 € 2 1

4! 1w GOOD MY 09261944 899528509 H 1 1 [
[1207 4 20 2 16502 GOOD JMMY 09261944 899528508 HEIDEMAN 1 1

42 1 B REEVES BERTHA 09011933 865-52.9060 6 2 2 [
[1207 4 21 2 3002 REEVES BERTHA 09011933 865-52.9060 6 2 2

402 1@ LECOMPTE  NICHOLAS 0B201918 634826965 E 1 1 [
[1206 4 22 2 20502 LECOMPTE  NICHOLAS 0B201918 634826965 EMERSON 1 1

4 0\ 1 s CLETT MARIE 08241922 904229717 w 2 1 [
[J205 4 23 2 27002 CLETT MARIE 08241922 904-22.9717 w 2 1

4 224 1B MORRIS SHERRIE 0927193 908528389 L 2 0 [
[1204 4 24 2 12502 MORRIS SHERRIE 0927193 908528389 LoLa 2 0

4 B 18 VASSALLO KATHLEEN 12151930 854129526 w 2 1 [
[1204 4 25 2 40002 VASSALLO KATHLEEN 12151930 854129526 w 2 1

4 B 1w STEWART NICOLA 09221971 858-02.9801 D 2 1 [
[1204 4 265 2 41502  STEWART NICOLA 09221971 858-02.9801 DORTHY 2 1

47 13 HIGGINS FRANCES 03211924 804625513 6 2 1 [
[l204 4 27 2 15002 HGGINS FRANCES 03211924 804625513 GOMEZ 2 1

4 0B’ 1@\ BISHOP PETER 08311935 BOB026771 I 1 1 [
[1203 4 28 2 46002 BISHOP PETER 08311935 BOB026771 I 1 1

4 2w 17 GOYETTE VICTOR 04111935 808527656 T 1 0 [
[J202 4 2 2 3002 GOYETTE VICTOR 04111935 808527656 TMOTHY 1 i
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Result:  The data is the column is re-formatted back to the original format.
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|Score | Class |Link ID |File |Record # | LNAME; Name-La| FNAME; Name-Fi| DOB;Birth Dat | SSN;Social Security Nun| Mi;Name-Middl| SEX,Sex|RACE;Race 1|DTH: 4|

FE TR ) BARTON LORA 0281948 BOBB2A247 F 2 T [
[1210 4 14 2 11502 BARTON LORA 06281945 B0GA25247 FRANCE 2 1
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4 B 1| MOURER BRUCE 09151940 922630012 N 1 1 w
[1210 4 16 2 24502 MOURER BRUCE 09151940 920630012 N 1 1

4 17 1 os KALTHOFF CHRISTINE B151909 825727261 i 2 2 [
[1208 4 17 2 26002  KALTHOFF CHRISTINE OB151909 825727261 i 2 2

4 1B 1 W WAITS ROBIN 09031935 B0BA25E21 s 2 1 [
[1208 4 18 2 17502 WAIS ROBIN 09031935 B0BA25821 s 2 1

4 18 1= MARSHALL  TIFFANY 0251948 BDA225244 € 2 1 [
[1207 4 19 2 11002 MARSHALL  TIFFANY 0B251948  BDB225244 € 2 1

4! 1w GOOD MY 09261944 899526509 H 1 1 [
[1207 4 20 2 16502 GOOD JMMY 09261944 899528509 HEIDEMAN 1 1

42 1 B REEVES BERTHA 09011933 BBS5290B0 6 2 2 [
[1207 4 21 2 3002 REEVES BERTHA 09011933 BBS5290BD 6 2 2

402 1@ LECOMPTE  NICHOLAS UB201918  B34B26986 E 1 1 [
[1206 4 22 2 20502 LECOMPTE  NICHOLAS 0B201918  H34826985 EMERSON 1 1

4 0\ 1 s CLETT MARIE 08241922 904229717 w 2 1 [
[J205 4 23 2 27002 CLETT MARIE 08241922 904229717 w 2 1

4 224 1B MORRIS SHERRIE 0927193 908528389 L 2 0 [
[1204 4 24 2 12502 MORRIS SHERRIE 0927193 90852389 LoLa 2 0

4 B 18 VASSALLO KATHLEEN 12151930 854129526 w 2 1 [
[1204 4 25 2 40002 VASSALLO KATHLEEN 12151930 854129526 w 2 1

4 B 1w STEWART NICOLA 09221971 858029801 D 2 1 [
[1204 4 265 2 41502  STEWART NICOLA 09221971 858029801 DORTHY 2 1

47 13 HIGGINS FRANCES 03211924 BO4E28513 6 2 1 [
[l204 4 27 2 15002 HGGINS FRANCES 03211924 BO4E25513 GOMEZ 2 1

4 0B’ 1@\ BISHOP PETER 08311935 B08026771 I 1 1 [
[1203 4 28 2 46002 BISHOP PETER 08311935 608026771 I 1 1

4 2w 17 GOYETTE VICTOR 04111935 BOBE27656 T 1 0 [
[J202 4 2 2 3002 GOYETTE VICTOR 04111935 808527655 TMOTHY 1 i
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Customizing the Color Scheme 

The default colors for the manual review screen are gray and white for alternating pair rows, pink for unmatched values, and yellow for missing values.  This color scheme is fully-customizable.

To modify the colors for alternating pair rows, unmatched and missing values, complete these steps: 
1. Click on the Manual Review menu item, and select Options…
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e 7= true matches s matches ] = uncertain matches = unmatched values = missing values
er— fs |Link ID |File |Record # |last name;last nar|first namesfirst nar|dobidob | ssmissn | sex;sex| A
Fuvedn T T MARGESSON  EDMUND 05271921 770141064 1 H
- 1 2 12 MARGESSON  EDMUND 05271921 770141084 1
Close iew 2 1113 MINTER DESIRE 01081933 787001635 2
2 2 13 MINTER DESIRE 01081933 787001635 2
T3 1o MARGESSON  EDMUND 05271921 770141084 1
[] 180 103 2 n MARGESSON  EDMUND 05271921 770141084 1
[t 1106 MOTT ADAM 08221945 790002345 1
[ 160 14 2 6 MOTT ADAM 08221945 790002345 1
15 1% MULLINS PRISCILLA 02101918 770000701 2
180 15 2 ® MULLINS PRISCILLA 02101918 770000701 2
[ 1% MUNNINGS  ANNA 10301954 773001212 2
[l 180 1B 2 % MUNNINGS — ANNA 10301954 773001212 2
17 1128 MUNNINGS  EDMOND 01111930 790000517 1
[] 180 17 2 128 MUNNINGS  EDMOND 01111930 790000517 1
18 1143 LONG ROBERT 01061922 772001816 1
[l 180 18 2 143 LONG ROBERT 01061922 772001816 1
1s 18 PRICE REBECCA 12261941 762002858 2
[] 180 19 2 PRICE REBECCA 12261941 762002858 2
110 1 1B PARK MARGERY 05231913 765003039 2
[l 180 110 2 1% PARK MARGERY 05231913 765003039 2
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114 1 143 ORTHS FRANCOIS 05211918 777001156 1
[l 180 114 2 143 ORTHS FRANCOIS 05211918 777001156 1
115 1 108 OLDHAM LUCRETIA 02211921 789006049 2
[] 180 115 2 108 OLDHAM LUCRETIA 02211921 789006049 2
116 1 128 BENFORD JACOB 10101928 752000518 1
[l 180 116 2 12 BENFORD JACOB 10101928 752000518 1
171 e GOULD GRACE 10141986 761001234 2
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Result:  The Options dialog box opens, with the Manual Review tab selected.
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[ 180 1o 2 12 MARGESSON  EDMUND 05271921 770141084 1
12 1113 MINTER DESIRE 01081933 787001635 2
[ 160 12 2 13 MINTER DESIRE 01081933 787001635 2
103 1o MARGESSON  EDMUND 05271921 770141084 1
[] 180 103 2 n MARGESSON  EDMUND 05271921 770141084 1
[t 1106 MOTT ADAM 08221945 790002345 1
[ 160 14 2 6 MOTT ADAM 08221945 790002345 1
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111 @ BREWSTER  JONATHAN 09101934 781008334 1
[] 180 11 2 3 BREWSTER  JONATHAN 09101934 781008334 1
114 1 143 ORTHS FRANCOIS 05211918 777001156 1
[l 180 114 2 143 ORTHS FRANCOIS 05211918 777001156 1
115 1 108 OLDHAM LUCRETIA 02211921 789006049 2
[] 180 115 2 108 OLDHAM LUCRETIA 02211921 789006049 2
116 1 128 BENFORD JACOB 10101928 752000518 1
[l 180 116 2 12 BENFORD JACOB 10101928 752000518 1
171 e GOULD GRACE 10141986 761001234 2
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2. To change any of the colors, select the color you would like to change from the box on the left (1st pair, 2nd pair, unmatched values, missing values) and then select the color of your choice from the color selection box on the right. Select Color for the first pair, and then select the third green box from the top.
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W B 1 9 PRICE CLARE 161926 812214719 2 T [
[J180 14 8 2 4002  PRICE CLARE 07161926 812124719 SESTER 2 1

4 w1 SPICER CATHERINE 0530197  BO2627835 2 1 [
[1173 4 70 2 38502 SPICER CATHERINE 0530197 BO2827835 2 1

4 1w MAYNARD JOHN 01221955 884129570 D 1 1 [
[J178 4 71 2 31502 MAYNARD JOHN 01221955 884129570 DOMINIC 1 1

4 02 1 W SENA JOHN 0301913 807425994 6 1 1 [
[1178 4 72 2 19002  SENA JOHN 03101913 807425994 GEORGE 1 1

4 B 1 @ NORIy — ——— P 1 1 [
s 4 B 2 e o PELOT 1

1574 103 ALFC Data Link Y Manual Review | Export A 2 1 o
178 15 74 2 1002 ALFC ANNE 2 1

P — EER Calorforthe 15t par B 7 o
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[J173 14 77 2 202 PME CANO 1 1

9 @ 1w HAW R 1 1 [
16 8 90 2 9502  HAW ROBERT 1 1

591 18 HALL A 2 1 [
[J14 15 91 2 302 HLL BEATHT 22T Tz A 2 1

B o@ 1 2 JACOBS EVE 03081935 BOS524200 K 2 1 [
[I113 15 9 2 502  JACOBS EVELYN 03081935 BOSE24207 K 2 1
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Result:  The Color for the first pair changes from gray to green in the box on the left.

3. Click Apply.

Result:  The color selection has changed on the manual review screen.
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4. Click on the Manual Review menu item, and select Options…
Result:  The Options dialog box opens, with the Manual Review tab selected.

5. Change the Color for the 1st pair back to medium gray (3rd gray box from top).

6. Click Apply.

Result:  The color selection has changed back to gray on the manual review screen.
Manually Assigning Match Status
Match status can be assigned manually by using the mouse to click in the Match Status check box or by using the keyboard.
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Assigning True Match Status:  For the comparison pair being reviewed place the cursor in the Match Status check box and left-click the mouse once, or press the “M” key to select the current pair as a true match and move on to review the next comparison pair. 

Assigning False Match Status:  For the comparison pair being reviewed place the cursor in the Match Status check box and left-click the mouse twice, or press the “N” key to select the current pair as a false match and move on to review the next comparison pair.
Assigning Uncertain Match Status:  For the comparison pair being reviewed place the cursor in the Match Status check box and left-click the mouse three times, or press the “B” key to select the current pair as an uncertain match and move on to review the next comparison pair.
Assigning Match Status Automatically by Score
When a linkage is run, Link Plus saves all potential matches that generated a score above the specified Cut Off Value in the linkage report.  When the linkage report is opened for manual review, all potential matches will be presented for review, even those that generated high scores and are almost certain to be matches, and (depending on the Cut Off Value specified) those that generated low scores and are almost certain to be false matches. With practice, after initial review of the list of comparison pairs it is often easy to identify an upper cut off score above which all pairs are true matches, and a lower cut off score below which all pairs are false matches. The remaining pairs are said to be in the “gray area”; uncertain matches requiring manual review. 

Rather than having to individually assign the match status to each comparison pair manually, Link Plus offers the option to automatically assign match status for groups of pairs by their match score.
To assign match status automatically by score, complete these steps:

1. Click on the Data menu item, and select the Assign Match Status… option.

[image: image76]
Result:  The Assign Match Status dialog box opens.

[image: image77]
The Assign Match Status dialog box offers the following options:
	Option
	Description

	Select all as true matches
	Selecting this button will assign a true match status to all comparison pairs in the current view 

	Select all as false matches
	Selecting this button will assign a false match status to all comparison pairs in the current view

	Select all as uncertain matches
	Selecting this button will assign an uncertain match status to all comparison pairs in the current view

	Select true matches by score
	Selecting this button will assign a true match status to all comparison pairs that have a score in the range specified in the from and to boxes

	Select false matches by score
	Selecting this button will assign a false match status to all comparison pairs that have a score in the range specified in the from and to boxes

	Select uncertain matches by score
	Selecting this button will assign an uncertain match status to all comparison pairs that have a score in the range specified in the from and to boxes


2. Click Cancel.

3. Review the comparison pairs, and attempt to identify a match score above which all comparison pairs are true matches.
4. Click on the Data menu item, and select the Assign Match Status… option.
5. Click on Select true matches by score from, enter the upper score you have identified in the first box, enter 21.5 in the second box, and then click OK.
Result:  The manual review screen re-opens with the specified match statuses assigned.
Display Uncertain Matches Only
While performing manual review, some users may prefer to view only the uncertain matches, and have those pairs that have been assigned a match status of true and false hidden from view.
The manual review screen may be restricted to display only uncertain matches in two different ways: 

1. Click on the Data menu item, and select the Display Uncertain Match Only option.
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Result:  Only uncertain matches will be displayed for review, and those pairs that have been assigned a match status of true and false are hidden from view.

2. Click on the Display Only Uncertain Matches icon [image: image79.png]kplus\VbDemo\report\workingview. default]
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 on the tool bar.

To return to a view that displays all matches, Click on the Data menu item, and select the Display All option.
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Result:  All matches will be displayed for review, regardless of match status.

The Pair View

While performing manual review, some users may prefer to view the comparison pairs individually rather than within the Datasheet View.  For these users, Links Plus offers the Pair View, which provides a side-by-side comparison of the two records being reviewed. 
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When working in the Pair View, match status can be assigned by using the mouse to click in the Match Status check box or by using the keyboard.
Assigning True Match Status:  Place the cursor in the Match Status check box and left-click the mouse once, or press the “M” key to select the current pair as a true match. 

Assigning False Match Status:  Place the cursor in the Match Status check box and left-click the mouse twice, or press the “N” key to select the current pair as a false match.

Assigning Uncertain Match Status:  Place the cursor in the Match Status check box and left-click the mouse three times, or press the “B” key to select the current pair as an uncertain match.

You can navigate between comparison pairs in the Pair View by clicking the Back and Next buttons. 

You can open the Pair View for a comparison pair in four different ways.  With the current record selected in the Datasheet View:

1. Press the Enter key to open the pair view for the current record.

2. Click on the Pair View Icon [image: image83.png]kplus\VbDemo\report\workingview. default]
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Score |Class |Linkage ID | Set ID = |Record # | Patient ID Number |Name-First _|Name-Last _|Name-Middle |Race 1 |Sex |Birth Date| a
1 461 99098 90000600 BENTO  DEVRES W 02 1 13080601 El
[ 330 6 1 461 99180 90000682 BENTO  DEVRES W 02 1 19080601
2 460 99027 90000529 GINA MCELROYS ~ KEYS 02 2 19190410
[ 330 5 2 460 99129 90000631 GINA MCELROYS  KEYS 02 2 19190410
3 459 99043 90000550 JAMARCUS RUDACILLE ~ Z ©2 1 e
[ 328 6 3 459 99148 90000650 JAMARCUS RUDACILLE ~ Z ©2 1 e
4 458 99029 90000531 DARRON ~ DOWDELL ~ NOLAND 02 1 19520425
o327 5 4 458 99131 90000633 DARRON  DOWDELL  NOLAND 02 1 19520425
5 457 99043 90000545 MARIA DEARDEN ~ MARIORE 01 2 19260515
L1323 6 5 457 99143 90000645 MARIA DEARDEN ~ MARIORE 01 2 19260515
6 456 99095 90000598 WAYLAND  DOPSON 9 1 19000306
316 5 6 456 99181 90000683 WAYLAND  DOPSON 9 1 19000306
7 455 99095 90000597 JAKOB BUSHONG B o1 en2r
L1316 6 7 455 99174 90000676 JAKOB BUSHONG B o1 wn2r
8 454 99025 90000527 TYRONE ~ WINFREY ~ ETCHINSON 01 1 1927019
315 6 8 45499127 90000629 TYRONE  WINFREY  ETCHINSON 01 1 19270519
9 453 99036 90000538 FORREST  LANKFORD o 1 19780105
L1314 6 9 453 99136 90000638 FORREST  LANKFORD o 1 19780105
10 452 99082 90000584 ESTER HIPP MAGDALENA 01 2 19561005
314 5 10 452 99187 90000689 ESTER HIPP MAGDALENA 01 2 19561005
1 451 99018 90000520 ZELA WHITTINGTON SCHABLE 01 2 13220201
L1313 6 1 451 99120 90000622 ZELA WHITTINGTON SCHABLE 01 2 13220201
12 450 99067 90000569 BEULAH  LANCON T 01 2 19390614
313 5 12 450 99167 90000669 BEULAH  LANCON T 01 2 19390614
13 449 90000875 MELONE ~ PURPLE CHAVIS 0 2 9T
L1312 6 13 449 90000696 MELONE ~ PURPLE  CHAVIS 0 2 9T
i 448 90000572 NELLA SUTTIE EUNICE 01 2 19720509
312 5 1 448 90000672 NELLA SUTTIE EUNICE 01 2 19720509
15 447 90000517 ORAL HAWS NOONKESTEF 01 1 19930306
L1312 6 15 a7 90000619 ORAL HAWS NOONKESTEF 01 1 19930306
% 446 90000543 STACY MAYS BRITTEN 01 2 19630804
[ 311 5 16 445 90000643 STACY MAYS BRITTEN 01 2 19630804
7 415 20000526 NONOVAN  HUTGH 20 1wt




 on the tool bar.

3. Right-click anywhere on the manual review screen, and select the Pair View…option.
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|Score | Class |Link ID |File |Record # | LNAME; Name-La| FNAME; Name-Fi| DOB;Birth Dat | SSN;Social Security Nun| Mi;Name-Middl| SEX,Sex|RACE;Race 1|DTH: 4|
[1184 4 B3 2 10002 RICKARD "AUDREY 01141921 BO1624953 2 T
4 B4 19 AVER DAVID 09151930 BDB226612 D 1 1 [
[1182 4 B4 2 45002 AVER DAVID 09151930 BDB226612 DALLAS 1 1
4 B 1o KEEL DAVID 08221922 622228984 J 1 1 [
[1182 4 B5 2 M2 KEEL DAVID 09221922 622228984 Y] 1 1
4 B 172 EDWARDS ALLISON 0451931 911630798 2 1 [
[1182 4 BB 2 35502 EDWARDS ALLISON 04051931 911630798 2 1
4 & 1 E CHAPPELL  WILLIAM 12041924 BI2127511 A 1 1 [
[1182 4 B7 2 3502 CHAPPELL  WILLIAM 12041924 BI2127511 ABRAHAM 1 1
5 B8 1 4 COGGINS BARERA 01271940 670224354 T 2 1 [
[1181 15 B8 2 1502 COGGINS BARBARA 01271942 807224354 T 2 1
W oB 19 PRICE CLARE 08161926 B12214719 2 1 [
L1180 14 B3 2 4002  PRICE CLARE 07161926 B12124719 SESTER 2 1
4 w1 SPICER CATHERINE 0530197  BO2627835 2 1 [
[1179 4 70 2 38502 SPICER CATHE Fomat » [po2e27835 2 1
4T 1 e MAYNARD JOHN  Restore OriginalFormat (884129570 D 1 1 i
[1178 4 71 2 3502 MAYNARD JOHN. _ Hd Column l884129570 DOMINIC 1 1
4 2 1 0®m SENA ot T 07 425954 6 1 1 o
[1179 4 72 2 19002 SENA JOHN 03101913 807425994 GEORGE 1 1
4 B 1 @ NORRIS MICHAEL 05091957 BODO26A27 P 1 1 [
[1178 4 73 2 15502 NORRIS MICHAEL 05091957 00025427 PELLOT 1 1
w74 13 ALFONSO KATHY S0B1936  BO2624186 A 2 1 [
[1178 15 74 2 1002 ALFONSO CATHY 0505193 BO2624167 ANNE 2 1
4 B 1 SIGMAN DEBORAH 03281925 843027830 2 1 [
[1176 4 75 2 26502  SIGMAN DEBORAH 03281926 843027830 2 1
4 1o VIRGA DENNIS 05211914 622628527 1 1 [
[1175 4 76 2 39502 VIRGA DENNIS 05211914 820628527 1 1
w718 PIMENTAL JOHN 11061934 BOEI4776 € 1 1 [
[1173 14 77 2 2502  PIMENTAL JOHN 11061904 BOBI24476 CANO 1 1 =
9 @ 1w HAWKINS TODD 09271937 999999999 R 1 1 [
[1116 9 90 2 9502 HAWKINS TODD 09271937 830226763 ROBERT 1 1
591 18 HALL BEATRIZ 03271949 90427042 A 2 1 [
R ————————— ey el iy A = z
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4. Click on the Data menu item, and select the Pair View… option.
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PR Ise matches || = uncertain matches = unmatched valuss Tissing values
_seoe | ooy NAMEName-Laf FNAME Name-Fi | DOB,Bith Dat | S5, Social Securty Nur|MiName-Mise| SEX,Sex |RACE, Race oTH 4|
ey RICE CLARE 8161926 812214719 2 T 0
1180 Sunmary RICE CLARE 07161928 812124719 SESTER 2 1
Fide-Unie/ColvReorcer...  [PICER CATHERINE 05301927 802827835 2 1 o
o179 Find PICER CATHERINE 05301827 602627835 2 1
AYNARD  JOHN 01221985 884129570 o 1 1 0
L7 — AYNARD  JOHN 01221955 884129570 Domme 1 1
T ——SENA JOHN 03101913 807425094 ® 1 1 o
179 4 72 2 tem  SENA JoHN 03101913 807425994 GEORGE 1 1
PR NORRIS MICHAEL 05091957 800025427 P 1 1 0
(178 4 73 2 1502 NORRS MICHAEL 05091957 B00025427 PELOT 1 1
5 o7 13 ALFONSO KATHY 05051935 802524166 A 2 1 o
178 15 74 2 1002 ALFONSO CATHY 05051935 802524167 ANNE 2 1
PR - SIGMAN DEBORAH 03281925 843027830 2 1 0
[176 4 75 2 2802 SIGMAN DEBORAH 03281926 643027800 2 1
4 78 1 8 VRoA DENNIS os2iiels 820528527 1 1 o
D75 4 78 2 302 VIRGA DENNIS os2iie1s 820528527 1 1
womo1 s PIMENTAL ~ JOHN 11061834 E08324776 c 1 1 0
(173 14 7 2 2502 PIMENTAL  JOHN 11061804 E08324476 cano 1 1
9 @ 1 HAWKINS T00D 0o071937 939999998 R 1 1 o
D116 9 % 2 902 HAWKNS 00D 09271937 830225763 ROBERT 1 1
5 o9t 1 8 HALL BEATRIZ om7iel  es0a7s A 2 1 0
L1415 8 2 32 HLL BEATRIZ o:2iea Bsnaz7O2d A 2 1
5@ 1 2 JACOBS EVE 03081935 BOSE24200 K 2 1 o
113 15 @ 2 52 JACOBS EVELN 03081935 B0SE24207 K 2 1
5 w1 13 MAILER CHARLENE 02181915 981529999 0 2 1 0
[102 15 @ 2 602  MALLER CHARLENE 02171915 981629984 DAILEY 2 1
1 oe 1 ews  woop ALVIN 12181815 eosos01a: P 1 1 o
(90 14 84 2 334 WOOD ALVIN O5141959 819527837 P 1 0
s 1 18 SILVERA ANDREA 08171926 00000000 B 2 1 0
[lel 14 % 2 802  SLVERA ANDREA o8171926 807124981 BOOTH 2 1
o 1 7234 WLLAMS KEVIN 10151827 e01a9748 1 2 o -
80 14 % 2 3B WILLAMS KEVIN 1081841 eos1274te CRAVEN 1 1
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5. Regardless of the way you opened the Pair View, for now, click Cancel to return to the Datasheet View.

Viewing Summary Information

Over the course of the manual review process, and upon its completion, you may want to view summary information regarding the total number of comparison pairs, true matches, false matches, and uncertain matches (as well as these totals for the pairs that are displayed) for the current review session.  Link Plus keeps track of this summary-level information, displays it upon command. 
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|Score | Class |Link ID |File |Record # | LNAME; Name-La| FNAME; Name-Fi| DOB;Birth Dat | SSN; Social Security Nun| Mi;Name-Middl| SEX,Sex|RACE;Race 1|DTH: 4|

T 5 170 HISER BRIDGET 261959 9BADEZ088 W 2 T w0
L2154 5 2 3812 HISER BRIDGET 08261959 9BADE26EB w 2 1

4 B 1% ROKISKY FELX 12111929 800125092 E 1 2 [
215 4 6 212002 ROKISKY FELIX 12111929 800125092 E 1 2

47 147 SEMPER BERNICE 05241915 634327209 v 2 1 [
215 4 7 2 2002 SEMPER BERNICE 05241915 834327209 v 2 1

4 8 1o TRIMARCHI  JUDITH 01111930 627228518 A 2 1 [
b2 4 8 2 3002 TRIMARCH  JUDITH 01111930 827228518 A 2 1

49 (- SCRUGGS CANDACE 01231948 826427688 L 2 1 [
f20 4 9 2 o _ecmices pveross ot aneieon i 5 4

PRI oy P =] i ]
L2104 2 Linkage 1D range |GG 1 1
210 2 ﬂ ; c Total pairs E Total displayed pairs E— 1 1 ®

4 12 1 4E Total tue matches BN Total displayed true matches [ 1 1 [
[ 21.0 4 12 2 2% Tota) false matches A Total displayed false matches o ! 1
e 2 E ; ;E Total uncertain matches  [SEMMMMN  Total displayed uncertain matches (S ; 1 ®

4w 1 T 2 1 [
L2104 14 2 1 2 1

4 15 1A CHESNOTT COFTON 27195 BOREZEA7T) o 1 1 [
[1210 4 15 2 14502 CHESNUTT CLIFTON 08271950 BOAB25470 MCGOUGH 1 1

4 B 1| MOURER BRUCE 09151940 922630012 N 1 1 [
[1210 4 16 2 24502 MOURER BRUCE 09151940 920630012 N 1 1

4 17 1 os KALTHOFF CHRISTINE B151909 825727261 i 2 2 [
[1208 4 17 2 26002  KALTHOFF CHRISTINE OB151909 825727261 i 2 2

4 1B 1 W WAITS ROBIN 09031935 B0BA25E21 s 2 1 [
[1208 4 18 2 17502 WAIS ROBIN 09031935 B0BA25821 s 2 1

4 18 1= MARSHALL  TIFFANY 0251948 BDA225244 € 2 1 [
[1207 4 19 2 11002 MARSHALL  TIFFANY 0B251948  BDB225244 € 2 1

4! 1w GOOD MY 09261944 899526509 H 1 1 [
[1207 4 20 2 16502 GOOD JMMY 09261944 899528509 HEIDEMAN 1 1
KN
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Summary information may be viewed in two different ways:

1. Click on the Data menu item, and select the Summary option.
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lsoe | o oy NAVEName-Laf FNAME Name-Fi | DOB,Bith Dat | SN Social Securty Nur|MiName-Mise | SEX,ex |RACE Race oTH 1|
] ISER BRIDGET 05261959 984002668 W 2 T o
215 o ISER BRIDGET 08261959 984002668 w 2 1
Fide-Lnie/colnReorcerr.  [OKISKY FEL 12111929 800125092 £ 1 2 o
0215 Find OKISKY FELX 12111828 enoi2s092 3 1 2
EMPER BERNICE osete1s 834327208 v 2 1 0
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T 5T ——TRMARCH  JUDITH oiiien  B27208sie A 2 1 o
D214 4 8 2 3002 TRMARCHI  JUDITH oiiie0  B27208s18 A 2 1
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210 4 12 2 20m  SMAL CLYDE 08231911 804726214 STERWALT 1 1
413 1 8 AMN ANGELNA 02131935 900529249 H 2 1 0
210 4 13 2 202 AMN ANGELINA 02131935 900629249 HARPER 2 1
PR TR T BARTON LORA 08I B0BEST F 2 1 o
210 4 14 2 11502 BARTON LORA 5281948 B0BB25247 FRANCE 2 1
45 1 o= CHESNUTT  CLIFTON oB271%E0 804825470 M 1 1 0
[1210 4 15 2 14502 CHESNUTT  CLFTON oB7I%E0  BO4E25470 MCGOUH 1 1
4 B 1w MOURER BRUCE ooISIn 820530012 N 1 1 o
210 4 16 2 24502 MOURER BRUCE ooisien 920530012 N 1 1
7 1 os KALTHOFF ~ CHRISTNE 011909 625727261 I 2 2 0
(1208 4 17 2 2802 KATHOFF  CHRISTNE 08151903 825727261 I 2 2
4 B8 1 3B wams ROBIN 0o031935 808625621 s 2 1 o
208 4 18 2 17502 WATS ROBIN o%031935 808625621 s 2 1
P ] MARSHALL ~ TIFFANY omstels  aoezosed c 2 1 0
(207 4 19 2 11002 MARSHALL  TIFANY omsiels  Agezos2M c 2 1
PR T 00D JMMY 0mBioM 839528508 H 1 1 o
207 4 0 2 18502 GOOD VMY 09261944 599528509 HEDEMAN 1 1
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2. Click on the Summary icon [image: image88.png]=181]
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|Score = |Class |Link ID |File |Record # | LNAME; Name-La| FNAME; Name-Fi| DOB;Birth Dat | SSN;Social Security Nun| Mi;Name--Middl| SEX,Sex | RACE;Race 1|DT 4|

T 1 146 MOOTRY DELMA 07201931 BO14Z6167 R 2 T (o
L1215 41 2 25m  MOOTRY DELMA 07201931 801426167 R 2 1

4 2 168 MALONE PEARLINE 04011920 804827393 J 2 1 [
215 4 2 2 3B02  MALONE PEARLINE 04011920 804827393 J 2 1

4 3 18 MAHAFFEY  AIMEE 0031922 BO3326262 P 2 1 [
L1215 4 3 2 4502 MAHAFFEY  AMEE 031922 80336262 P 2 1

44 12 TRIANA SAMANTHA  DE211921 813125345 F 2 1 [
215 44 210502 TRIANA SAMANTHA  DS211921 813125345 F 2 1

4 5 17 HISER BRIDGET 08261959 9BADE26E8 w 2 1 [
L1215 4 5 2 3812 HISER BRIDGET 08261959 9BADE26EB w 2 1

4 B 1% ROKISKY FELX 12111929 800125092 E 1 2 [
215 4 B 212002 ROKISKY FELIX 12111929 800125092 E 1 2

47 147 SEMPER BERNICE 05241915 634327209 v 2 1 [
L1215 47 2 2002 SEMPER BERNICE 05241915 834327209 v 2 1

4 8 1o TRIMARCHI  JUDITH 01111930 627228518 A 2 1 [
211 4 8 2 3002 TRIMARCH  JUDITH 01111930 827228518 A 2 1

49 (- SCRUGGS CANDACE 01231948 826427688 L 2 1 [
L1210 4 3 2 30002 SCRUGGS CANDACE 01231948 826427688 LINDA 2 1

4 0 1 B KULLA IMMIE 1M2\I91E BA27122 T 1 1 [
210 410 2 31002 KULLA IMMIE 1261918 804127122 TERRELL 1 1

4 1 1 SENG JULES 11191945 BE2628726 v 1 1 [
L1210 41 2 2902 SENG JULES 11191945 BE2628726 VAZQUEZ 1 1

4 12 1 s SMALL CLYDE 08231911 804726214 s 1 1 [
210 412 2 2002 SMALL CLYDE 08231911 804726214 STERWALT 1 1

4 13 1 om AMIN ANGELINA 02131935 900E29249 H 2 1 [
L1210 413 2 2302 AMN ANGELINA 02131935 900E29249 HARPER 2 1

4 141 BARTON LORA 0281948 BDBE25247 F 2 1 [
210 4 14 2 11502 BARTON LORA 0281948 BOBE25247 FRANCE 2 1

4 15 1 @™ CHESNUTT CLFTON 08271950 BO4B25470 M 1 1 [
L1210 4 15 2 14502 CHESNUTT CLFTON 08271950 BOAB25470 MCGOUGH 1 1

4 B 1| MOURER BRUCE 09151940 922630012 N 1 1 [
210 4 16 2 24502 MOURER BRUCE 09151940 920630012 N 1 1
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 on the tool bar.

3. View the summary information and click Close.

Using the Search Feature 

During the manual review process, you may want to find a word within one of the data columns.  Link Plus provides a search feature that allows you to do so.
To use the manual review search feature complete these steps:

1. Click on the Data menu item, and select the Find option.
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| |score Doy ncetan atch Oty NAME;Name-La| FNAME; Name-Fi| DOE; Bith Dat| SSN;Social Security Nun] M Name--Midd]| SEX;Sex| RACE:Race | DTH |
BT ISER BRIDGET 261959 9BADEZ088 W 2 T w0
L1215 Summary. ISER BRIDGET 08261959 9BADE26EB w 2 1
Hide-Lnhide{Column- Reorder.._{OKISKY FELIX 12111929 800125092 E 1 2 [
[l215 OKISKY FELIX 12111929 800125092 E 1 2
EMPER BERNICE 05241915 634327209 v 2 1 [
L1215 Em— EMPER BERNICE 05241915 834327209 v 2 1
T—& T 77 TRIMARCHI  JUDITH 01111930 627228518 A 2 1 [
b211 4 8 2 3002 TRMARCHI  JUDITH 01111930 827228518 A 2 1
49 (- SCRUGGS CANDACE 01231948 826427688 L 2 1 [
210 4 9 2 W02 SCRUGGS CANDACE 01231948 826427688 LINDA 2 1
4 0 1 B KULLA IMMIE 1M2\I91E BA27122 T 1 1 [
210 4 10 2 31002 KULLA IMMIE 1261918 804127122 TERRELL 1 1
4 1 1 SENG JULES 11191945 BE2628726 v 1 1 [
[l210 4 11 2 2902 SENG JULES 11191945 BE2628726 VAZQUEZ 1 1
4 12 1 s SMALL CLYDE 08231911 804726214 s 1 1 [
[210 4 12 2 20002 SMALL CLYDE 08231911 804726214 STERWALT 1 1
4 13 1 om AMIN ANGELINA 02131935 900E29249 H 2 1 [
[210 4 13 2 2302 AMN ANGELINA 02131935 900E29249 HARPER 2 1
4 141 BARTON LORA 0281948 BDBE25247 F 2 1 [
[1210 4 14 2 11512 BARTON LORA 0281948 BOBE25247 FRANCE 2 1
4 15 1 @™ CHESNUTT CLFTON 08271950 BO4B25470 M 1 1 [
[1210 4 15 2 14502 CHESNUTT CLFTON 08271950 BOAB25470 MCGOUGH 1 1
4 B 1| MOURER BRUCE 09151940 922630012 N 1 1 [
[1210 4 16 2 24502 MOURER BRUCE 09151940 920630012 N 1 1
4 17 1 os KALTHOFF CHRISTINE B151909 825727261 i 2 2 [
[1208 4 17 2 26002 KALTHOFF CHRISTINE OB151909 825727261 i 2 2
4 1B 1 W WAITS ROBIN 09031935 B0BA25E21 s 2 1 [
[I208 4 18 2 17502 WATS ROBIN 09031935 B0BA25821 s 2 1
4 18 1= MARSHALL  TIFFANY 0251948 BDA225244 € 2 1 [
[1207 4 13 2 11002 MARSHALL  TIFFANY 0B251948  BDB225244 € 2 1
4! 1w GOOD MY 09261944 899526509 H 1 1 [
[1207 4 20 2 16502 GOOD MY 09261944 899528509 HEIDEMAN 1 1
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OR, click on the Find icon [image: image90.png]kplus\VbDemo\report\workingview. default]

LI =EIRRS
1 = true matches lse matches [] = uncertain matches = unmatched values = missing values,
Score |Class |Linkage ID | Set ID = |Record # | Patient ID Number |Name-First _|Name-Last _|Name-Middle |Race 1 |Sex |Birth Date| a
1 461 99098 90000600 BENTO  DEVRES W 02 1 13080601 El
[ 330 6 1 461 99180 90000682 BENTO  DEVRES W 02 1 19080601
2 460 99027 90000529 GINA MCELROYS ~ KEYS 02 2 19190410
[ 330 5 2 460 99129 90000631 GINA MCELROYS  KEYS 02 2 19190410
3 459 99043 90000550 JAMARCUS RUDACILLE ~ Z ©2 1 e
[ 328 6 3 459 99148 90000650 JAMARCUS RUDACILLE ~ Z ©2 1 e
4 458 99029 90000531 DARRON ~ DOWDELL ~ NOLAND 02 1 19520425
o327 5 4 458 99131 90000633 DARRON  DOWDELL  NOLAND 02 1 19520425
5 457 99043 90000545 MARIA DEARDEN ~ MARIORE 01 2 19260515
L1323 6 5 457 99143 90000645 MARIA DEARDEN ~ MARIORE 01 2 19260515
6 456 99095 90000598 WAYLAND  DOPSON 9 1 19000306
316 5 6 456 99181 90000683 WAYLAND  DOPSON 9 1 19000306
7 455 99095 90000597 JAKOB BUSHONG B o1 en2r
L1316 6 7 455 99174 90000676 JAKOB BUSHONG B o1 wn2r
8 454 99025 90000527 TYRONE ~ WINFREY ~ ETCHINSON 01 1 1927019
315 6 8 45499127 90000629 TYRONE  WINFREY  ETCHINSON 01 1 19270519
9 453 99036 90000538 FORREST  LANKFORD o 1 19780105
L1314 6 9 453 99136 90000638 FORREST  LANKFORD o 1 19780105
10 452 99082 90000584 ESTER HIPP MAGDALENA 01 2 19561005
314 5 10 452 99187 90000689 ESTER HIPP MAGDALENA 01 2 19561005
1 451 99018 90000520 ZELA WHITTINGTON SCHABLE 01 2 13220201
L1313 6 1 451 99120 90000622 ZELA WHITTINGTON SCHABLE 01 2 13220201
12 450 99067 90000569 BEULAH  LANCON T 01 2 19390614
313 5 12 450 99167 90000669 BEULAH  LANCON T 01 2 19390614
13 449 90000875 MELONE ~ PURPLE CHAVIS 0 2 9T
L1312 6 13 449 90000696 MELONE ~ PURPLE  CHAVIS 0 2 9T
i 448 90000572 NELLA SUTTIE EUNICE 01 2 19720509
312 5 1 448 90000672 NELLA SUTTIE EUNICE 01 2 19720509
15 447 90000517 ORAL HAWS NOONKESTEF 01 1 19930306
L1312 6 15 a7 90000619 ORAL HAWS NOONKESTEF 01 1 19930306
% 446 90000543 STACY MAYS BRITTEN 01 2 19630804
[ 311 5 16 445 90000643 STACY MAYS BRITTEN 01 2 19630804
7 415 20000526 NONOVAN  HUTGH 20 1wt




 on the tool bar.
Result: The Find dialog box opens.
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|Score | Class |Link ID |File |Record # | LNAME; Name-La| FNAME; Name-Fi| DOB;Birth Dat | SSN; Social Security Nun| Mi;Name-Middl| SEX,Sex|RACE;Race 1|DTH: 4|

T 5 170 HISER BRIDGET 261959 9BADEZ088 W 2 T w0
L2154 5 2 3812 HISER BRIDGET 08261959 9BADE26EB w 2 1

4 B 1% ROKISKY FELX 12111929 800125092 E 1 2 [
215 4 6 212002 ROKISKY FELIX 12111929 800125092 E 1 2

47 147 SEMPER BERNICE 05241915 634327209 v 2 1 [
215 4 7 2 2002 SEMPER BERNICE 05241915 834327209 v 2 1

4 8 1o TRIMARCHI  JUDITH 01111930 627228518 A 2 1 [
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2. Enter the word BARTON in the Find what box.  
3. Click the Match case check box.

4. Select the LNAME;Name—Last column from the pull-down list.
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5. Select the Down search direction button, and click Find Next.

Result: Link Plus highlights the first occurrence in the down direction of the search term BARTON in the LNAME;Name—Last column. 
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Saving and Re-opening Review Sessions

Any review session may be saved as a .view file, and re-opened to at a later time.  To save this review session, complete these steps:
1. Click on the Manual Review menu item and select the Save View As… option.

[image: image94.png]=181]

Manual Review Data Help

e Ve, B[v =¥
open iew.

R [71= true matches. lse matches || = uncertain matches. = unmatched values missing values

e Link 1D |Fie|Record # |LNAME:Name-La FNAME:Name-Fi| DOB;Birth Dat | SS; Social Security Nun|MiName-iddl | SEX. Sex | RACE; Race 1|DTH 2|

Ctian 5 170 HISER BRIDGET 6261959 964032868 W 2 1 w
5 2 3812 HISER BRIDGET 06261959 984032868 w 2 1
Close iew 6 1 ROKISKY FELIX 12111928 BOD125092 E 1 2 [
options. 6 212002 ROKISKY FELIX 12111923 BOD125092 E 1 2
T 7 14 SEMPER BERNICE 05241915 834327209 v 2 1 i
215 4 7 2 2002 SEMPER BERNICE 05241915 834327209 v 2 1
4 8 [ TRIMARCHI JUDITH 01111930 827228518 A 2 1 i
b2 4 8 2 3002 TRIMARCHI JUDITH 01111930 827228518 A 2 1
4 3 16l SCRUGGS CANDACE 01231948 626427688 L 2 1 i
210 4 9 2 30002 SCRUGGS CANDACE 01231948 626427608 LINDA 2 1
4 1 & KULLA JMMIE 11281918 804127122 T 1 1 i
210 4 10 2 31002 KULLA JIMMIE 11281918 804127122 TERRELL 1 1
4 1 1 @ SENG JULES 11191945 862826726 v 1 1 i
[J210 4 11 2 2902 SENG JULES 11191945 BB2826726 VATQUEZ 1 1
4 12 1 SMALL CLYDE 08231911 804726214 s 1 1 i
210 4 12 2 2002 SMALL CLYDE 06231911 804726214 STIERWALT 1 1
4 13 1@, AMIN ANGELINA 02131935 900629249 H 2 1 i
[1210 4 13 2 2302 AMN ANGELINA 02131935 900629249 HARPER 2 1
4w 1 BARTON LORA 06281948 BGA25247 F 2 1 i
[1210 4 14 2 11502 BARTON LORA 06281945 B0GA25247 FRANCE 2 1
4 15 1 @ CHESNUTT CLIFTON 06271950 804825470 M 1 1 i
[1210 4 15 2 14502 CHESNUTT CLIFTON 06271950 80425470 MCGOUGH 1 1
4 B 1 & MOURER BRUCE 09151340 922530012 N 1 1 i
[1210 4 16 2 24502 MOURER BRUCE 09151340 922530012 N 1 1
4 7 1 &= KALTHOFF CHRISTINE 06151909 625727261 1 2 2 i
[1208 4 17 2 26002  KALTHOFF CHRISTINE 06151909 625727261 1 2 2
4 1 1 ® WAITS ROBIN 09031935 B06625621 s 2 1 i
[1208 4 18 2 17502 WAIS ROBIN 09031935 606625621 s 2 1
4 13 1 3\ MARSHALL ~ TIFFANY 06251348 806225244 c 2 1 i
[1207 4 19 2 11002 MARSHALL  TIFFANY 06251348 806225244 c 2 1
4w 1w 600D JMMY 09261944 899528509 H 1 1 i
[1207 4 20 2 16502 GOOD JMMY 09261944 899528509 HEIDEMAN 1 1
KN

A)start] | 5] Lok Pus Traini... | ) ClricaReview... | &]ahool Mail-k... | &) COC- Cirix Me... | [2] Microsoft Powe... |18 Link Plus - [ Inbox - icroso...| [« EJ[2] #s6Pm





Result:  The Save View dialog box opens.
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2. Enter NewViewName.view in the File name box.

3. Click Save.

To re-open a saved review session, complete these steps:

1. Click on the Manual Review menu item and select the Open View option.
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Result:  The Open Linkage View File dialog box opens.
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2. Enter NewViewName.view in the File name box and click Open.

Result:  The manual review screen opens with the linkage view displayed. 

Independent Manual Review

Using the information you have just learned about the manual review screen, take some time and resolve a few matches on your own, making sure to view the summary information at least once.  
Feel free to modify the screen layout as desired – re-order, re-size or hide columns, change the color scheme, or view the comparison pairs in Datasheet or Pair View. 
Assigning Final Match Statuses
To assign the final match statuses for today’s external linkage exercise automatically by score, complete these steps:

1. Click on the Data menu item, and select the Assign Match Status… option.
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Result:  The Assign Match Status dialog box opens.
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2. Click on Select true matches by score from, enter 10.2 in the first box, enter 21.5 in the second box, and then click OK.

Result:  The manual review screen re-opens with the specified match statuses assigned.

Of the 99 comparison pairs presented for review during today’s external linkage exercise, there were only four false matches.  These were the comparison pairs with the Linkage IDs of 94, 96, 97 and 99.  Note the low scores these pairs received.
3. Manually assign a false match status to the comparison pairs with the Linkage IDs of 94, 96, 97, and 99.  

4. Manually assign a true match status to the comparison pairs with the Linkage IDs of 95 and 98.  

Step 15:  Export Merged File

Once you have completed your manual review of the potential matches presented for review, and have assigned a match status to them (either manually by clicking, or via the Data…Assign Match Status option), you will want to export a merged file.  Link Plus offers the export of the merged file in a text file in delimited file format, and allows you to specify what file delimiter you would like to use.

To set the export file format option and export a merged file, complete these steps:

1. Click on the Manual Review menu item, and click on Options…
[image: image100.png]sorkingview.default] =18 x|

Manual Review Data Help
e iew. B[Y[ =%
e 7= true matches s matches ] = uncertain matches = unmatched values = missing values
er— fs |Link ID |File |Record # |last name;last nar|first namesfirst nar|dobidob | ssmissn | sex;sex| A
Fuvedn T T MARGESSON  EDMUND 05271921 770141064 1 H
- 1 2 12 MARGESSON  EDMUND 05271921 770141084 1
Close iew 2 1113 MINTER DESIRE 01081933 787001635 2
2 2 13 MINTER DESIRE 01081933 787001635 2
T3 1o MARGESSON  EDMUND 05271921 770141084 1
[] 180 103 2 n MARGESSON  EDMUND 05271921 770141084 1
[t 1106 MOTT ADAM 08221945 790002345 1
[ 160 14 2 6 MOTT ADAM 08221945 790002345 1
15 1% MULLINS PRISCILLA 02101918 770000701 2
180 15 2 ® MULLINS PRISCILLA 02101918 770000701 2
[ 1% MUNNINGS  ANNA 10301954 773001212 2
[l 180 1B 2 % MUNNINGS — ANNA 10301954 773001212 2
17 1128 MUNNINGS  EDMOND 01111930 790000517 1
[] 180 17 2 128 MUNNINGS  EDMOND 01111930 790000517 1
18 1143 LONG ROBERT 01061922 772001816 1
[l 180 18 2 143 LONG ROBERT 01061922 772001816 1
1s 18 PRICE REBECCA 12261941 762002858 2
[] 180 19 2 PRICE REBECCA 12261941 762002858 2
110 1 1B PARK MARGERY 05231913 765003039 2
[l 180 110 2 1% PARK MARGERY 05231913 765003039 2
L READE MABEL 03151925 769003739 2
[] 180 1o 2 4 READE MABEL 03151925 769003739 2
o121 5 COOKE GEORGE 01021950 790222485 1
[l 180 112 2 5 COOKE GEORGE 01021950 790222485 1
111 @ BREWSTER  JONATHAN 09101934 781008334 1
[] 180 11 2 3 BREWSTER  JONATHAN 09101934 781008334 1
114 1 143 ORTHS FRANCOIS 05211918 777001156 1
[l 180 114 2 143 ORTHS FRANCOIS 05211918 777001156 1
115 1 108 OLDHAM LUCRETIA 02211921 789006049 2
[] 180 115 2 108 OLDHAM LUCRETIA 02211921 789006049 2
116 1 128 BENFORD JACOB 10101928 752000518 1
[l 180 116 2 12 BENFORD JACOB 10101928 752000518 1
171 e GOULD GRACE 10141986 761001234 2

@start| | &) Yahoo! Wl - Wthoburn... | &) CDC - Girix MetaFrame ... | [] Microsoft PowerPeint - ... | ] Link Flus Training Linkage... [ {8 Link Plus - [view=C [« B ezaam





Result:  The Options dialog box opens.
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2. Click on the Export tab.

Result:  The Export Options dialog box opens.
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3. To set the export file format option to comma delimited, click on Comma, and then click the OK button.

Result:  The export file format has now been set to a comma delimited file format.
4. To export the file, click on the Data menu item, and click on Export…
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Result:  The Export Setting dialog box opens.
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4. Select the fields from File 1 and File 2 that you would like in your merged file by clicking the box in the column to the left of the data field.
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6. Click on the Export button.

Result:  A window opens where you can specify a name for the exported merged file, and location on your PC or on a shared network folder where you would like to save the file. The default location for exported files within Link Plus is the C:/RegPlus/LinkPlus/Report folder.
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7. In the File name box, type external1.txt, and click the Save button.

Result: A comma delimited merged file with the data fields you selected, named external1.txt, is generated and placed in the C:/RegPlus/LinkPlus/Report folder.  In addition, Notepad will open with a view of the merged file.
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	If you are having trouble viewing the information in this file, you can adjust the font size and turn off the Word Wrap option under the Format menu in Notepad.
This file can be easily imported into Microsoft Excel.


8. Close out of Notepad and click Cancel on the Export Setting dialog box to return to the manual review screen.

9. Click on the Manual Review menu item, and select the Close View option.
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Result:  The main Link Plus window opens.
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File Import for Delimited Files

The steps required to configure a linkage for delimited files is the same for those for fixed width files, with the exception of the file import process.  Within the file import process, the assigning of variable names is slightly different; rather than entering the variable names and positions, you first specify the file delimiter, and then assign the variable names from pull-down menus.
To become familiar with the different import process for delimited files, complete these steps: 
1. Click on the File menu option, and select New Linkage.
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Result:  The Link Plus Linkage Configuration window opens.
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2. Select the data type of Delimited from the Data Type drop-down menu for File 1.
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3. Click on the folder icon to the right of the input box for File 1.
[image: image114.png]Fle_Manual Review Dzt _Help

=181]

e@an[E[E]v]= [

Data Type:

Leimi=d K

File 1

Fixed Width

Select blocking variables

<] Fie2

Select ID variables (File 1)

Data ltem (File 1)

Data ltem (File 2)

Phanetic System

Select matching variables and methods

Select ID variables (File 2)

Data ltem (File 1)

Data ltem (File 2)

Matching Methad

Missing Value (File 1)

Add
[lease set the parameters and

Remove

Add Remove
then click the Run button

[ Missing Value (File 2) ——— & Direct Method

Cutoff Value:

Results will be saved to

L

Advanced

Save

Cancel

|

[CRegPlus\LinkPlusireportiLinkageReport bt

Run
]

Bston] | [ aosct v

(58] Link Plus Training Linkage... | )3 Internet Explorer

~|[ tink Pius - [tinkage C.

Inbox - Microsoft Outoa.

[EB soom




Result: The Open Data File dialog box opens.
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4. Select the Delimdemofile1.dat file, and click the Open button.

Result:  The Data Import Form for Delimited File opens.
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5. The data file, Delimdemofile1.dat is a comma delimited file; click on Comma, and then click View Data.

Result:  The data are displayed correctly in their proper columns, but without variable names.
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6. Click on the Column 1 column header.

Result: A pull-down menu appears.
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7. Select Name—Last from the pull-down menu to label column 1.
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You would continue to label columns in this manner until all of the columns are labeled, and then click on OK.  Link Plus would then return to the Link Plus Linkage Configuration window, where you would complete the linkage configuration.
8. Click Cancel.

Deduplication Linkage Exercise
About the Data
Today’s deduplication linkage exercise will involve linking a cancer registry data file to itself in an attempt to identify duplicate records.  
Simulated Cancer Registry Records

The data file CCRV11.dat is a fixed width data file containing 10,003 simulated cancer registry records in the NAACCR (North American Association of Central Cancer Registries) Record Layout Version 11 format.  
Linkage Results

105 records on the cancer registry data file potentially match themselves and are potential duplicates; these records are presented for manual review.  
Beginning the Deduplication Exercise

To begin today’s deduplication linkage exercise, complete the following steps:

1. Click on the File menu option, select New Deduplication, and select Fixed Width File.
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Result:  The Link Plus Deduplicating Configuration window opens.
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Review of Deduplication Linkage Steps

1. Select Data Type for Data File 

2. Locate/Identify Data File 

3. Data Import for Data File 

4. Select Blocking Variables & Phonetic System

5. Select Matching Variables & Matching Methods

6. Select ID Variables

7. Define Missing Values

8. Select Direct/EM Method

9. Enter Cut-off Value

10. Specify Linkage File Name and Location

11. Perform Manual Review of Uncertain Matches
12. Export Merged File

Step 1:  Select Data Type for Data File 

As you have just seen, when you select a new deduplication linkage from the file menu, you specify the data type for the file at the same time, so at this point Link Plus knows the data type is fixed width.  
Step 2:  Locate/Identify Data File
To locate the CCRV11.dat data file complete these steps:

1. Click on the folder icon to the right of the Data File input box.
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Result: The Open Data File dialog box opens.
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2. Click on the CCRV11.dat file, and click the Open button.

Result:  The Data Import Form for Fixed Width File opens.
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Step 3:  Data Import for Data File
To finish the data import process for the data file, complete these steps:

1. Click on the folder icon to the right of the Record Layout File box.

Result:  The Open Record Layout File dialog box opens.
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2. Click on the NAACCR11DEFAULT.txt record layout.

Result:  The NAACCR11DEFAULT.txt record layout is selected into the File name box.
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3. Click on the Open button.
Result:  You are returned to the Data Import Form for Fixed Width File window, with the NAACCR Version 11 record layout entered automatically in the record layout grid.
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4. Click on View Data.
Result:  Link Plus displays the first 20 lines of data in the file in the NAACCR Version 11 record layout, so you can verify you have the proper positions and lengths for the variables. 
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5. Click the OK button.
Result: The record layout is saved, and the application returns you to the Deduplicating Configuration window.
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Step 4:  Select Blocking Variables & Phonetic System
To select blocking variables and a phonetic system (where applicable), complete these steps:

1. Click on the first empty Data Item cell of the grid in the Select blocking variables section. 
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Result:  A drop-down menu appears. When clicked, this menu contains all of the variable names of the variables to be imported for the data file (CCRV11.dat).
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2. Using the drop-down menus for the Data Item and Phonetic System columns, make the following selections for blocking variables and phonetic systems:

	Data Item 
	Phonetic System

	Name--Last
	Soundex

	Name--First 
	Soundex

	Birth Date
	

	Social Security Number
	


Step 5:  Select Matching Variables & Matching Methods
To select matching variables and their respective matching methods, complete these steps:

1. Click on the first empty Data Item cell of the grid in the Select matching variables and methods section.
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Result:  A drop-down menu appears. When clicked, this menu contains all of the variable names of the variables to be imported for the data file (CCRV11.dat). 
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2. Using the drop-down menus for the Data Item and Matching Method columns, make the following selections for matching variables and matching methods:

	Data Item 
	Matching Method

	Birth Date 
	Date

	Name--Last
	Last Name

	Name--First 
	First Name

	Name--Middle
	Middle Name

	Social Security Number 
	SSN

	Sex
	Exact


Step 6:  Define Missing Values
Link Plus automatically treats null or empty values as missing data for Matching Variables and allows the user to indicate additional values which are to be treated as missing data by the program.

To define missing values for the matching variables selected, complete these steps:

1. Select the Birth date matching variable Variable common to the two files that is used for comparing records by clicking on its row in the matching variables grid.

Result:  The missing values and format grid for dates appears.
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Remember that entering missing values for date variables works a little differently from other variables.  Missing values are specified separately for each of the date components; day, month, and year.
2. Enter the missing values in the following table:
	Date Component
	Missing Value 

	Day
	99

	Month
	99

	Year
	9999


3. In addition to specifying missing values separately for each of the date components, the date format must also be specified.  
Link Plus accepts two date formats, MMDDYYYY, and YYYYMMDD.  The cancer registry file (in the NAACCR record layout) uses the MMDDYYYY date format.  

Use the pull-down menu in the format row of the grid to select the MMDDYYYY format.
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4. Select the Name--Last matching variable Variable common to the two files that is used for comparing records by clicking on its row in the matching variables grid.
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5. Click the Add button in the Missing Values grid.
Result: A cell opens where you can enter a missing value for the last name variable.
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6. Type UNKNOWN in the cell, and click Add. 

7. Type UNK in the new cell that appears.

8. Select the Name--First matching variable Variable common to the two files that is used for comparing records by clicking on its row in the matching variables grid, and repeat steps 5-7.

9. Select the Social Security Number matching variable Variable common to the two files that is used for comparing records by clicking on its row in the matching variables grid.

10. Click the Add button in the Missing Values grid.

11. Type 999999999 in the cell and click Add.  Type 000000000 in the new cell that appears.
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	You can add up to 5 Missing Values.  Missing Values can be deleted by clicking the Remove button.


Step 7:  Select ID Variables
Although Link Plus reports will automatically include Matching Variables, you may want to define other variables to be included in the reports, called ID Variables.  ID Variables, such as Patient ID Number and Record #, are variables used for identifying records.  Selection of ID Variables is optional.  

To select ID Variables for the data file, click in the Select ID variables grid, and select the Patient ID Number variable from the drop-down list that appears.
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Step 8:  Select Direct/EM Method
For the purposes of today’s deduplication linkage exercise, we will be using the Direct Method to derive the M-Probabilities used in the linkage.  The M-Probability is the probability that a matching variable agrees given that a comparison pair is a match.  When the Direct Method box is clicked, default M-Probabilities are used in the linkage.  Leave the Direct Method box clicked.
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	You can click on Advanced to view the default M-Probabilities or define your own.
Un-click the Direct Method box if you prefer Link Plus to compute the M-Probabilities based on your data using the EM algorithm


Step 9:  Enter Cut-off Value
Remember that the Cut Off Value is the score value above which comparison pairs are accepted as potential links and presented for manual review.  For the purposes of today’s deduplication linkage exercise, enter an initial Cut Off Value of 7 in the Cutoff Value box. 
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Step 10:  Specify Linkage File Name and Location
At the completion of a deduplication linkage run, Link Plus will generate a Linkage Report, named LinkageReport.txt, and store it in the Report folder of the Link Plus directory.  The report is a tab delimited text file, and can be opened with a text editor or a spreadsheet program. 
The report header lists the files that were used and all of the parameters that were set for the run. Below the header is the report detail.  Records are presented in comparison pairs sorted by their linkage scores, in descending order.  Pairs with scores above the selected cut off value are listed. The detail row for each record contains all of the matching and ID variables Variables used for identifying records such as patient ID and record ID. used in the linkage.

You will need to rename the linkage report or it will be over-written the next time you run Link Plus. 

To rename the Linkage Report, complete these steps:
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 to the right of Results will be saved to.
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Result:  The Save linkage results to the file below dialog box opens.
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2. Enter DedupLink.txt in the File name box, and click Save.
Result: The application returns you to the Deduplicating Configuration window, where the linkage report name has been changed to DedupLink.txt.
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3. Click on Save to save the configuration file for this deduplication linkage exercise.
Result: The Save Configuration dialog box opens.
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4. Enter DedupLink.cfg in the File name box, and click Save.
5. Click Run to run the linkage.
Result:  The linkage is run, and Link Plus generates a Linkage Report named DedupLink.txt, which is automatically opened within Notepad.
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6. Close this window. 
7. Result: Link Plus returns to the Deduplicating Configuration screen, with a message issued in green along the bottom of the screen, indicating that the linkage is complete.
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Step 11:  Perform Manual Review of Uncertain Matches
To conduct manual review of the potential matches generated by the deduplication linkage that was just performed, open the DedupLink.txt linkage report in a new view and then perform the manual review, assigning a match status to each potential match.

To open the deduplication linkage report for manual review, complete these steps:

1. On the Linkage Configuration screen, click on the Manual Review menu item, and click on the New View… option. 
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Result:  The Select Linkage Report for Manual View dialog box opens.
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2. Select the DedupLink.txt linkage report, and click Open.

3. Click OK.
Result: The manual review screen opens for the DedupLink.txt linkage report. 
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Note that for deduplication linkages, you do not select any additional variables for manual review, so the view opens directly.  Although you do not select any additional variables for review, you can still fully customize the manual review screen, and perform all of the same functions that we learned about earlier when performing the manual review for the external linkage exercise: 

· Individual columns may be sorted, hidden/unhidden from view, and re-sized
· The order and format of the columns on the review screen may be modified
· The color scheme may be modified

· Match status can be assigned both manually and automatically by match score 

· The list of comparison pairs can be restricted to display uncertain matches only

· You can choose between the Datasheet View and the Pair View
· You can view and modify the coding for the Class variable

· You can view summary information for the manual review process 

· You can use the search feature
· You can save and re-open views
As for external linkages, the default view for the manual review of uncertain matches is the Datasheet View, where comparison pairs are sorted together and displayed in alternating rows of white and gray colored background.  In addition, unmatched and missing values for matching variables are highlighted in pink and yellow, respectively.

From the main Manual Review screen, you can access all of the same menu items for the Link Plus manual review process as those for the external linkage we performed earlier, plus one addition option. For manual review of deduplication linkages, Link Plus generates one additional identifier called a Set ID.  The Set ID is a unique number assigned to each group of duplicated records because a record may have multiple duplicates.  The Set ID may be manually re-assigned. 
Prior to performing the manual review of uncertain matches, we will first hide the columns of Record # and Patient ID, and learn a little more about the Set ID.

Hide Record # and Patient ID Columns
To hide the columns of Record # and Patient ID Number complete these steps:

1. Click on the Data menu item and select the Hide-Unhide/Column-reorder option.

Result: The Hide-unhide/Reorder Columns dialog box opens.
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Select the Record # variable from the Displayed list, and click on the left arrow button to move it over to the Hidden list. 
Result:  The Record # column is moved to the list of hidden columns.
2. Select the Patient ID Number variable from the Displayed list, and click on the left arrow button to move it over to the Hidden list.

Result:  The Patient ID Number column is moved to the list of hidden columns.
[image: image155.png]=181]

CIEIE = EIRdEANS
= true matches Ise matches || = uncertain matches = unmatched values values
|Score < |Class |Linkage ID | Set ID |Record # | Patient ID Nurbe| Bith Date | Name--Last | Name--First | Name-Middl Social Security Num\TSex | =
1257 2 B 7547 10007470 05231915 CLAYTON  ARCADIO  C 126007191 T
E 15 B912  100DEEES 11151901 HASSAN  JENNFER MALET 120009264 2
[1254 R 15 B9 100DEES 11151901 GREENWAY JENNIFER MALET 120009264 2
El 14 EM4 1000533 11031967 GIESEMAN  NONA KILLOUGH 847004094 2
[]243 4 o 14 591 1000533 11231967 GIESEMAN  NONA KILLOUGH 847004094 2
92 13 H0SD 10005045 10051933 MILLETT  JOSELYN L 359270000 2
[1243 4 @2 13 H097 10006045 11051933 MILLETT  JOSELYN L 359270000 2
93 12 471 10001456 09151971 JENKINS  JAIMIE L 654004084 2
[ 236 uw o= 12 29 emoviee oot i e i . SADDAEA 5
94 i o 14530000 2
[l 234 1w 11 90 Hidden Displayed 22002756 2
9% 10 9B [Record# Score ok | Jriinnn 2
L1234 n % 10 g7 |Patient ID Number Class T pooraoess 2
% 9 a7 rkage ID Cancel | b7an01352 2
[l 225 15 % R ol |5ih pate 78001532 2
97 8 = Name-Last 127850000 1
[l 208 2 9 8 & Name-First 127850000 1
98 7 73 Name--Middle 158003062 1
[ 19.4 4 @ 7 57¢ 222‘3‘ Security Number = 158003082 1
99 6 Bl B 00020358 1
[] 194 4 9 6 BD: 00020358 1
100 5 1815 TUIUZBAT 251925 RARIN TILCE ENIAD 162003438 2
[117.4 31 5 2847 10002620 01261923 SEMIAD  TILLIE KARINA 182003438 2
101 4 1177 10001165 06021900 DELOZER ~ELDON  E 000817260 1
[] 144 5 01 4 7% 10001165 06131900 RANDINO ~ ELDON  E 000817260 1
02 3 44 10000874 07031902 WINKLER ~ QUINN M 450000001 1
[ 134 13 3 983 10000874 07031902 EDGE QUINN M 00942655 1
103 1 032 10000597 03261926 LUSTIG PATRICK  PHILLIP  BOSD0892 1
[174 1510 1 10003 10000583 03261926 BETTIN ERICK s 605008529 1
104 1 E9 10000583 03261926 BETTIN ERICK SUMPTER  BOSD0B529 1
7.4 15104 1 1032 10000597 03261926 LUSTIG PATRICK  PHILLIP  BOSD0B592 1
105 0 20 10002633 08271965 BREED GERRY U 920050000 1
[l72 1510 0 M9 100080 01191994 DOYAL GERRY U 540090000 1 =
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	Remember, a column may also be hidden from view by right-clicking on the column in the Datasheet View, and selecting the Hide Column option.


3. Click OK.

Result:  Link Plus returns to the main manual review screen, with the Record # and Patient ID Number columns hidden from view.
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QE[AD=[E[V]=[¥
= true matches Ise matches || = uncertain matches = unmatched values = missing values,
|Score = |Class |Linkage ID |Set ID | Bith Date| Name-Last | Name-First | Name-Middl{ Social Security Numi|Sex | A
T 04 07251941 MOREHOUSE ELVA MELODY 791004685 2 H
]38 2 1 104 07251941 MOREHOUSE MELODY  ELVA 791004685 2
2 103 05141994 LINGER FREDERICK T 1BB001B10 1
[l3%3 12 103 05141994 LINGER FREDERICK T 188001810 1
3 102 11051913 LORENZEN ~ AUBREY  ILIANA 402710000 2
[133 103 102 11051913 LORENZEN ~ AUBREY  ILANA 402710000 2
4 01 11221916 MACE ALLNE  MARIETTA 522000779 2
[l3%3 14 101 11221916 MACE ALLNE  MARIETTA 522000779 2
5 00 01181986 LYLE ROSEANNA H 6BB005422 2
[133 15 100 01181986 LYLE ROSEANNA H 6BB005422 2
6 99 04131927 FAGUE SHANNA  VOLLE 000497520 2
[l3%3 1B 99 04131927 FAGUE SHANNA  VOLLE 000497520 2
7 98 05151980 LEGER HIRAM HAROLD 529170000 1
[133 17 98 05151980 LEGER HIRAM HAROLD 529170000 1
8 97 04281971 CONNELLY ~DILLAN  ERICK  DD0418997 1
[l3%3 18 97 04281971 CONNELLY DILLAN  ERICK  DD0418997 1
9 9 09201957 CREASY  TRESSA H OD05BB01E 2
[133 19 9 09201957 CREASY  TRESSA H ODD5EBO1E 2
0 95 05131974 EDDIE AMADOR  HERMANN  DD0237349 1
[l3%3 10 95 05131974 EDDIE AMADOR  HERMANN  DD0237349 1
11 94 05241944 DIEL EDD DARREN 110002377 1
[133 1o 94 05241944 DIEL EDD DARREN 110002377 1
2 93 02161903 CARRON  ZADA MILLE 076007457 2
[l3%3 112 93 D2161903 CARRON  ZADA MILLE 076007457 2
13 92 07151933 OUTLAW  DERWIN  F 328004030 1
[133 1o 92 07151933 OUTLAW  DERWIN  F 328004030 1
14 91 DA171974 FARRER PANSY R 622006595 2
[l3%3 11 91 04171974 FARRER PANSY R 822006595 2
15 90 0921945 GIUFFRE  MIKAELA G 135050000 2
[133 118 90 09221945 GIUFFRE  MIKAELA G 135050000 2
15 89 DI071921 KRUSHINSKI ELIZABETH LEE 000299354 2
[l3%3 16 89 01071921 KRUSHINSKI ELIZABETH LEE 000299354 2
17 88 11091922 HULTENIUS  MARGARETT D (D0B5E522 2
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Sort by and Manually Reassign Set ID

The Set ID is generated only for deduplication linkages, and is a unique number assigned to each group of duplicated records because a record may have multiple duplicates.  The Set ID may be manually reassigned. 

The CCRV11.dat data file contains one record with potential multiple duplicates; the comparison pairs for this record have been assigned a Set ID of 1.  Scroll down the list of comparison pairs until you find the pair assigned the Linkage ID of 60; this is the first of three comparison pairs that have been assigned a Set ID of 1. 

[image: image158.png]Manual Review Data_Help

=181]

od[# D E[E[v=[
= true matches Ise matches || = uncertain matches = unmatched values = missing values,
|Score < |Class |Linkage ID | Set ID |Birth Date |Name-Last | Name-First | Name-Middl Social Security Numi|Sex |
T 0361926 BETTIN ERICK SUMPTER  BUSD0B529 T
[1343 1 E 1 0361926 BETTIN ERICK s 605008529 1
61 44 DAD219B3 LINCK RICHARD  NORTHCUTT 000510293 1
[1343 1B 44 DAD219B3 LINCK RICHARD N OD0B10293 1
62 43 DB171944 BLEE F CEDRICK 000128523 1
[318 2 8 43 DB171944 BLEE FERDINAND CEDRICK 000128523 1
63 42 D91BI9IE COUSINS  AXEL 0BO03894 1
[] 304 1B 42 D91BI915 COUSINS  AXEL 0BOD3894 1
64 41 12131983 PROSIFKA  BENITO 829007147 1
[ 304 1 41 12131983 PROSIFKA  BENITO 829007147 1
65 40 03151989 ALLIS JARRET 279007129 1
[] 304 18 40 03151989 ALLIS JARRET 279007129 1
66 39 DAD71943 SALYERS  ASHER 947006628 1
[ 304 1 6B 39 DAD71943 SALYERS  ASHER 947006628 1
67 3 DBO71945 STICKNEY  JACINTO 248002777 1
[] 304 1w 38 DBO71945 STICKNEY  JACINTO 248002777 1
68 1021195 SCHICK BARE 042000133 2
[ 304 1 6 7 1021195 SCHICK BARE N 042000133 2
69 3 02231949 BRAMLETT  MODESTO 997000433 1
[] 304 1 36 02231949 BRAMLETT  MODESTO 997000433 1
0 35 10141913 ROGERS  DORSEY 940007685 1
[ 304 1w 35 10141913 ROGERS  DORSEY 940007635 1 =
7 34 0524196 BANKSTON  KATHARINE 911007885 2
[] 304 1N 34 0524196 BANKSTON  KATHARINE 911007885 2
72 3™ 09171946 IZATT LELAH 419000605 2
[ 304 1 3 09171946 1ZATT LELAH 419000605 2
73 32 09131916 HANDLEY — KENDAL 004004741 1
[] 304 17 32 09131916 HANDLEY  KENDAL  STAUNTON 04004741 1
7 31 0271979 KOCK ALBERT 00046793 1
[ 304 1 31 02271979 KOCK ALBERT 000046793 1
75 30 11281978 FETZER LASHAWN 599000024 1
[] 304 17 30 11281978 FETZER LASHAWN 509000024 1
75 9 DBD19I2 FEW JAMIE 18009106 2
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To see all three of the comparison pairs assigned the Set ID of 1, sort the list of comparison pairs by Set ID in ascending order by left-clicking once on the column heading of Set ID, and then scrolling to the top of the list.
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QE[AD=[E[V]=[¥
= true matches Ise matches || = uncertain matches = unmatched values = missing values,
|score |Class |Linkage ID | Set Iz | Birth Date| Name--Last | Name-First | Name-Middl| Social Security Numi| Sex | A
05 0 0827195 BREED GERRY U 520050000 T H
[l72 15108 0 01191994 DOYAL GERRY U 540090000 1
60 1 03261926 BETTIN ERICK SUMPTER  BOS08529 1
[1343 1 1 0361926 BETTIN ERICK s 605008529 1
103 1 036196 LUSTIC PATRICK  PHILLIP  BOSD08592 1
[174 1510 1 0361926 BETTIN ERICK s 605008529 1
104 1 03261926 BETTIN ERICK SUMPTER  BOSD0B529 1
7.4 15104 1 0361926 LUSTIG PATRICK  PHILLP  BOSD0B592 1
102 3 07031902 WINKLER  QUINN M 450000001 1
[1 134 13w 3 O7031902 EDGE QUINN M 00942655 1
101 4 DBO21900 DELOZER  ELDON  E 000817260 1
[ 144 5 101 4 DB131900 RANDINO  ELDON  E 000817260 1
100 5 DI251923 KARINA TILLE SEMIAO 182003438 2
[117.4 3 m 5 01251923 SEMIAO TILLE KARINA 182003438 2
99 6 JACOBSEN ~ GRAHAM 000020358 1
[ 194 499 6 12021970 JACOBSEN  GRAHAM 000020358 1
98 7 04181942 MACLAREN  GIOVANNY 453003082 1
[] 194 4 . 7 DMI81912 MACLAREN  GIOVANNY 453003082 1
97 8 12051992 BURTON CcLOVIS 027860000 1
[l 208 297 8 12051932 BURTON RAYMOND 027860000 1
% 9 O5051946 GOODIN HILMA w 678001352 2
[l 225 15 % 9 DS061945 GOODWIN  HILMA w 678001532 2
95 10 DI231962 KITCHEN  RACQUEL T 1111111 2
[l 234 1% 10 01231952 KITCHEN  RACQUEL T 000190858 2
94 11 DBO21976 BAYLIS TAMATHA M 314590000 2
[] 234 "oow 11 DBO21976 BAYLIS TAMATHA M 522002756 2
93 12 09151971 JENKINS  JAIMIE L 654004084 2
[l 236 L] 12 09141949 JENKINS  JAMIE L 354004084 2
%2 13 10051933 MILLETT JOSELYN L 359270000 2
[]243 4 @2 13 11051933 MILLETT JOSELYN L 359270000 2
El 14 11031967 GIESEMAN  NONA KILLOUGH 847004094 2
[1243 491 14 11231967 GIESEMAN  NONA KILLOUGH 847004094 2
90 15 11151901 HASSAN  JENNIFER MALET 120009264 2
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Note that the three comparison pairs assigned the Set ID of 1 (Linkage IDs of 60, 103 and 104) have very different scores. The first pair, both with the name of ERICK BETTIN and a DOB of 03261926 (Linkage ID of 60), has a very high score, and is definitely a duplicate record.  
However, the next two pairs (Linkage IDs 103 and 104) both have a DOB of 03261926 and a SSN that varies by the transposition of the last two numbers, but do not match at all on name.  They have very low scores, and are definitely not duplicates.

As a result, you will want to disassociate the Set IDs of the comparison pair with Linkage ID 60 from those of 103 and 104.  To do this, you need to reassign the Set IDs.

To reassign Set IDs, complete these steps:

1. Click on the Data menu item, and select the Reassign Set ID option.

[image: image160.png]Manusl Review | Data Help

B[ P tiew

| |score g:z:z::meakhomy Date|Name-Last _|Name~First | Name-MiddlSocial Security Nurl Sex |
ey 1965 BREED GERRY U 920050000 T
L7z Sunmary 1994 DOYAL GERRY U 540090000 1
Hide-Lniide/ColReorder.. 1926 BETTIN ERCK  SUMPTER 605008529 1
343 Find 1925 BETTIN ERICK 8 605008529 1
1926 LUSTIG PATRICK  PHILLP 605008592 1
7.4 — 1926 BETTIN ERCK S 605008529 1
—— S for———T——zbie2s BETIN ERICK  SUMPTER 605008529 1
7.4 15 104 1 0326196 LUSTIG PATRICK  PHILLP 605008592 1
102 3 07031302 WINKLER  QUNN M 450000001 1
L1134 13 12 3 07031902 EDGE QUNN M 000942655 1
101 4 OB21900 DELOZER  ELDON  E 000817260 1
[SRIYY 5 o 4 0BI3190 RANDNO  ELDON  E 000817260 1
00 5 015193 KARNA  TILLE SEMIAO 182003438 2
Ll17.4 3 M0 5 0251923 SEMIAO  TILLE KARINA 182003438 2
% 6 JACOBSEN  GRAHAM 000020358 1
194 4 e 6 12021970 JACOBSEN  GRAHAM 000020358 1
% 7 04181942 MACLAREN ~ GIOVANNY 458003082 1
[19.4 4 = 7 04181912 MACLAREN  GIOVANNY 458003082 1
Ed 8 12051982 BURTON  CLOVIS 027860000 1
208 2 o 5 12051992 BURTON  RAYMOND 027860000 1
% 9 051945 GOODN  HIMA W 678001352 2
25 5 % 9 05081945 GOODWIN  HILMA W 678001532 2
% 10 01231852 KITCHEN ~ RACOUEL T i 2
[ 234 "o 10 01231952 KITCHEN  RACOUEL T om0190688 2
9 1 oen2ie7e BAYLS TAMATHA M 314590000 2
L2354 "o 1 08021976 BAYLIS TAMATHA M 22002756 2
£ 1 DIISIETI JENKINS  JAME L 854004084 2
[ 236 u = 12 09141949 JENKINS  JAME L 354004084 2
% 13 10051833 MILLETT  JOSELYN L 359270000 2
243 PR 13 11051933 MILLETT  JOSELYN L 359270000 2
o1 14 11031867 GIESEMAN NONA  KILLOUGH 847004034 2
243 4 e 14 11231967 GIESEMAN NONA  KILLOUGH 847004094 2
£l 15 11151801 HASSAN  JENNFER MALET 120008264 2
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Result:  Set ID is automatically reassigned by individual comparison pair.
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QE[AD=[E[V]=[¥
= true matches Ise matches || = uncertain matches = unmatched values = missing values,
|score |Class |Linkage ID | Set I | Birth Date| Name--Last | Name-First | Name-Middl| Social Security Numi| Sex | A
1 0 07251941 MOREHOUSE ELVA MELODY 791004685 2 H
]38 2 1 0 07251941 MOREHOUSE MELODY  ELVA 791004685 2
2 1 05141994 LNGER FREDERICK T 1BB001B10 1
1353 12 1 05141994 LNGER FREDERICK T 188001810 1
3 2 11051913 LORENZEN ~ AUBREY  ILANA 402710000 2
L1353 103 2 11051913 LORENZEN ~ AUBREY  ILANA 402710000 2
4 3 11221916 MACE ALLNE  MARIETTA 522000779 2
1353 14 3 11221996 MACE ALLNE  MARIETTA 522000779 2
5 4 01181988 LYLE ROSEANNA H 6BB005422 2
L1353 15 4 D1181986 LYLE ROSEANNA H 6BB005422 2
6 5 04131927 FAGUE SHANNA  VOLLE 000497520 2
1353 1B 5 04131927 FAGUE SHANNA  VOLLE 000497520 2
7 6 05151980 LEGER HIRAM HAROLD 529170000 1
L1353 17 6 05151980 LEGER HIRAM HAROLD 529170000 1
8 7 041971 CONNELLY DILLAN  ERICK  DD0418997 1
1353 18 7 DA%1971 CONNELLY DILLAN  ERICK  DD0418997 1
9 8 09201957 CREASY  TRESSA H OD05BB01E 2
L1353 19 8 09201957 CREASY  TRESSA H ODD5EBO1E 2
0 9 05131974 EDDIE AMADOR  HERMANN  DD0237349 1
[l3%3 10 9 05131974 EDDIE AMADOR  HERMANN  DD0237349 1
11 10 05241944 DIEL EDD DARREN 110002377 1
[133 1o 10 05241944 DIEL EDD DARREN 110002377 1
2 11 (2161903 CARRON  ZAIDA MILLE 076007457 2
[l3%3 112 11 (2151903 CARRON  ZAIDA MILLE 076007457 2
13 12 07151933 OUTLAW  DERWIN  F 328004030 1
[133 1o 12 07151933 OUTLAW  DERWIN  F 328004030 1
14 13 04171974 FARRER PANSY R 622006595 2
[l3%3 11 13 04171974 FARRER PANSY R 822006595 2
15 14 09221945 GIUFFRE  MIKAELA G 135050000 2
[133 118 14 09221945 GIUFFRE  MIKAELA G 135050000 2
15 15 DI071921 KRUSHINSKI ELIZABETH LEE 000299354 2
[l3%3 16 15 01071921 KRUSHINSKI ELIZABETH LEE 000299354 2
17 16 11091922 HULTENIUS  MARGARETT D (D0B5E522 2
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2. Scroll down the list of comparison pairs until you see the pair assigned the Linkage ID of 60; it has now been assigned a unique Set ID of 59.
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QE[AD=[E[V]=[¥
= true matches Ise matches || = uncertain matches = unmatched values = missing values,
|score |Class |Linkage ID | Set I | Birth Date| Name--Last | Name-First | Name-Middl| Social Security Numi| Sex |
60 59 0326192 BETTIN ERICK SUMPTER  BUSD0B529 T
[1343 16 59 0361926 BETTIN ERICK s 605008529 1
61 B0 DAD21963 LINCK RICHARD  NORTHCUTT 000510293 1
[1343 1B B0 DAD21963 LINCK RICHARD N OD0B10293 1
62 61 DB171944 BLEE F CEDRICK 000128523 1
[318 2 8 61 DB171944 BLEE FERDINAND CEDRICK 000128523 1
63 62 D91BI9IE COUSINS  AXEL 0BO03894 1
[] 304 1B 62 D9161915 COUSINS  AXEL 0BOD3894 1
64 63 12131983 PROSIFKA  BENITO 829007147 1
[ 304 1 63 12131983 PROSIFKA  BENITO 829007147 1
65 64 03151939 ALLIS JARRET 279007129 1
[] 304 18 64 03151939 ALLIS JARRET 279007129 1
66 65  DAD71943 SALYERS  ASHER 947006628 1
[ 304 1 6B 65  DAD71943 SALYERS  ASHER 947006628 1
67 65 DBO71945 STICKNEY  JACINTO 248002777 1
[] 304 1w 66 DBO71945 STICKNEY  JACINTO 248002777 1
68 67 10211959 SCHICK BARE 042000133 2
[ 304 1 6 67 10211959 SCHICK BARE N 042000133 2
69 63 02231949 BRAMLETT  MODESTO 997000433 1
[] 304 1 63 02231949 BRAMLETT  MODESTO 997000433 1
0 69 10141913 ROGERS  DORSEY 940007685 1
[ 304 1w 69 10141913 ROGERS  DORSEY 940007635 1 o
7 70 0524195 BANKSTON  KATHARINE 911007885 2
[] 304 1N 70 0524196 BANKSTON  KATHARINE 911007885 2
72 71 09171946 IZATT LELAH 419000605 2
[1304 1 71 09171946 1ZATT LELAH 419000605 2
73 72 09131916 HANDLEY — KENDAL 004004741 1
[] 304 17 72 09131916 HANDLEY  KENDAL  STAUNTON 04004741 1
7 73 0271979 KOCK ALBERT 00046793 1
[ 304 1 73 02271979 KOCK ALBERT 000046793 1
75 74 11281978 FETZER LASHAWN 599000024 1
[] 304 17 74 11281978 FETZER LASHAWN 509000024 1
75 75 DBD1912 FEW JAMIE 18009106 2
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3. Scroll down the list of comparison pairs until you see the pairs assigned the Linkage IDs of 103 and 104; they have now been assigned unique Set IDs of 102 and 103.
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Assigning Match Status - Review
Similar to manual review for external linkages, match status can be assigned manually within deduplication manual review by using the mouse to click in the Match Status check box or by using the keyboard, or can be assigned automatically by match score.

[image: image164.png]=181]
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EE =] RdEED
= true matches lse matches || = uncertain matches = unmatched values missing values
|Score | Class |Link ID |File |Record # | LNAME; Name-La| FNAME; Name-Fi| DOB;Birth Dat | SSN; Social Security Nun| Mi;Name-Middl| SEX,Sex|RACE;Race 1|DTH: 4|

T 5 170 HISER BRIDGET 261959 9BADEZ088 W 2 T w0
L2154 5 2 3812 HISER BRIDGET 08261959 9BADE26EB w 2 1

4 B 1% ROKISKY FELX 12111929 800125092 E 1 2 [
215 4 6 212002 ROKISKY FELIX 12111929 800125092 E 1 2

47 147 SEMPER BERNICE 05241915 634327209 v 2 1 [
215 4 7 2 2002 SEMPER BERNICE 05241915 834327209 v 2 1

4 8 1o TRIMARCHI  JUDITH 01111930 627228518 A 2 1 [
b2 4 8 2 3002 TRIMARCH  JUDITH 01111930 827228518 A 2 1

49 (- SCRUGGS CANDACE 01231948 826427688 L 2 1 [
210 4 9 2 30002 SCRUGGS CANDACE 01231948 826427688 LINDA 2 1

4 0 1 B KULLA IMMIE 1M2\I91E BA27122 T 1 1 [
210 4 10 2 31002 KULLA JIMMIE 11281918 804127122 TERRELL 1 1

4 1 1 SENG JULES 11191945 BE2628726 v 1 1 [
[J210 4 11 2 2902 SENG JULES 11191945 BB2826726 VAZQUEZ 1 1

4 12 1 s SMALL CLYDE 08231911 804726214 s 1 1 [
210 4 12 2 2002 SMALL CLYDE 06231911 804726214 STERWALT 1 1

4 13 1 om AMIN ANGELINA 02131935 900E29249 H 2 1 [
[1210 4 13 2 2302 AMN ANGELINA 02131935 900E29249 HARPER 2 1

4 141 BARTON LORA 0281948 BDBE25247 F 2 1 [
[1210 4 14 2 11502 BARTON LORA 06281945 B0GA25247 FRANCE 2 1

4 15 1 @™ CHESNUTT CLFTON 08271950 BO4B25470 M 1 1 [
[1210 4 15 2 14502 CHESNUTT CLIFTON 08271950 BOAB25470 MCGOUGH 1 1

4 B 1| MOURER BRUCE 09151940 922630012 N 1 1 [
[1210 4 16 2 24502 MOURER BRUCE 09151940 920630012 N 1 1

4 17 1 os KALTHOFF CHRISTINE B151909 825727261 i 2 2 [
[1208 4 17 2 26002  KALTHOFF CHRISTINE OB151909 825727261 i 2 2

4 1B 1 W WAITS ROBIN 09031935 B0BA25E21 s 2 1 [
[1208 4 18 2 17502 WAIS ROBIN 09031935 B0BA25821 s 2 1

4 18 1= MARSHALL  TIFFANY 0251948 BDA225244 € 2 1 [
[1207 4 19 2 11002 MARSHALL  TIFFANY 0B251948  BDB225244 € 2 1

4! 1w GOOD MY 09261944 899526509 H 1 1 [
[1207 4 20 2 16502 GOOD JMMY 09261944 899528509 HEIDEMAN 1 1
KN
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To assign match status manually, for the comparison pair being reviewed place the cursor in the Match Status check box and:
· Left-click the mouse once, or press the “M” key to assign a true match status. 

· Left-click the mouse twice, or press the “N” key to assign a false match status.
· Left-click the mouse three times, or press the “B” key to assign an uncertain match status.
To assign match status automatically by score, click on the Data menu item, and select the Assign Match Status… option.

[image: image165]
Result:  The Assign Match Status dialog box opens.


[image: image166]
Enter any scores for which you would like to assign match status automatically, and click OK.
Independent Manual Review

Using the information you have learned today about the manual review process, configure the manual review screen to your liking, and experiment with the different options. Feel free to modify the screen layout as desired; re-order, re-size or hide columns, change the color scheme, or view the comparison pairs in Datasheet or Pair View. 
Take some time and resolve a few matches on your own, making sure to view the summary information at least once.  
Assigning Final Match Statuses

For today’s deduplication exercise, we have a little help to resolve the uncertain matches and assign a final match status of true or false.  The duplicate records within the CCRV11.dat data file have been assigned the same Patient ID Number; so all true matches will agree on Patient ID Number.  Unhide the Patient ID Number column to see if your decisions on match status were correct.  Only three pairs were false matches – did you find them?  To assign the final match statuses for this deduplication linkage exercise, complete these steps:

1. Click on the Data menu item, and select the Assign Match Status… option.

[image: image167]
Result:  The Assign Match Status dialog box opens.
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CIEEGEESEEE
= true matches lse matches ] = uncertain matches = unmatched values = missing values,
|score |Class |Linkage ID | Set ID | Birth Date| Name--Last | Name-First | Name-Middl| Social Security Numi| Sex | A
1 0 07251941 MOREHOUSE ELVA MELODY 791004685 2 H
]38 2 1 0 07251941 MOREHOUSE MELODY  ELVA 791004685 2
2 1 05141994 LNGER FREDERICK T 1BB001B10 1
1353 12 1 05141934 LINGER FREDERICK T 188001810 1
3 2 11051913 LORENZEN ~ AUBREY  ILANA 402710000 2
L1353 13 2 11051913 LORENZEN ~ AUBREY  ILANA 402710000 2
4 3 11221916 MACE ALLNE  MARIETTA 522000779 2
1353 14 3 n Matich Status
5 4
et s 4@ Selectal a5 true matches
1353 1B 5 Select all as false matches
7 6
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2. Click on Select all as true matches, and then click OK.

Result:  The manual review screen re-opens with all of the comparison pairs assigned a true match status.

Of the 105 comparison pairs presented for review during today’s external linkage exercise, there were only three false matches.  These were the comparison pairs with the Linkage IDs of 103, 104, and 105.  Note the low scores these pairs received.

3. Manually assign a false match status to the comparison pairs with the Linkage IDs of 103, 104, and 105.  

Step 12:  Export Merged File

Once you have completed your manual review of the potential matches presented for review, and have assigned a match status to them (either manually by clicking, or via the Data…Assign Match Status option), you will want to export a merged file.  Link Plus offers the export of the merged file in a text file in delimited file format, and allows you to specify what file delimiter you would like to use.

To set the export file format option and export a merged file, complete these steps:

1. Click on the Manual Review menu item, and click on Options…
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Result:  The Options dialog box opens.
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2. Click on the Export tab.

Result:  The Export Options dialog box opens.
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3. To set the export file format option to tab delimited, click on Tab, and then click OK.

Result:  The export file format has now been set to a tab delimited file format.
4. To export the file, click on the Data menu item, and select the Export… option.
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Result:  The Export dialog box for deduplication linkage opens.
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Link Plus offers the option to save both a file of true linked and distinctive records (sorted by Set ID), as well as a file of true linked pairs (sorted by Set ID).

5. Click on the folder icon to the right of the Save all true linked and distinctive records sorted by Set ID to the tab delimited file below box.

Result:  The Create a tab delimited file dialog box opens.
[image: image174.png]2ix =181]
dedupt.txt hes. = unmatched values = missing values.
Deduplink.txt Hol Social Security Nur| Sex |
S, T
LinkageReport, bt 120009264 2
ton MatchReprt bt 120009254 2
Deskion 847004094 2
847004094 2
359270000 2
My Dacuments 25927000 2
654004084 2
- 354004084 2
.‘.; 314590000 2
My Computer 522002756 2
1111111 2
File name: [True._dstinctive = [s== | oooioosse 2
Saveastps  [TentFies < Cancel 678001352 2
L] 678001532 2
027860000 1
o7 Export Close 027860000 1
E 453003082 1
19.4 4 = 97 DAIBI912 MACLAREN  GIOVANNY 453003082 1
99 98 JACOBSEN  GRAHAM 00020358 1
194 4 98 12021970 JACOBSEN ~ GRAHAM 000020358 1
100 99 01251923 KARINA TILLE SEMIAO 182003438 2
174 3 1m 99 01251923 SEMIAO TILLE KARINA 182003438 2
101 100 0B021900 DELOZER  ELDON  E 000817260 1
144 5 10 100 0B131900 RANDINO  ELDON  E 000817260 1
02 01 07031902 WINKLER  QUINN M 450000001 1
134 13102 101 07031902 EDGE QUINN M 00942655 1
103 02 03261926 LUSTIG PATRICK  PHILLIP  BOSD0892 1
1510 02 03261926 BETTIN ERICK s 605008529 1
104 103 03261926 BETTIN ERICK SUMPTER  BOSD0B529 1
15104 103 03261926 LUSTIG PATRICK  PHILLIP  BOSD0B592 1
105 104 08271965 BREED GERRY U 920050000 1 o
1510 104 01191994 DOYAL GERRY U 540090000 1

[l Phas - [-nage Report=Ci RegPLe LN PRs FeportDedspl e ot
@ start| | [9]5 Mirasoft OF... +| & 3 Internet Exp... | 3 C:lRegPlusiink... | ) 3 Notepad | () Uik Plus Users ... [ Link Plus - [Lin... |2 Microsoft Off..+| | <« 8 1027 AM





6. Enter True_distinctive.txt in the File name box, and click Save.

Result: The Export dialog box re-opens with the file of true linked and distinctive records (sorted by Set ID) named True_distinctive.txt, and the file of true linked pairs (sorted by Set ID) automatically named True_distinctive_Pairs.txt.
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7. Click Export.

Result: A tab delimited file of true linked and distinctive records sorted by Set ID named True_distinctive.txt is generated and placed in the C:/RegPlus/LinkPlus/Report folder.  Notepad will open with a view of this file.
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In addition, A tab delimited file of true linked pairs sorted by Set ID named True_distinctive_Pairs.txt. is also generated and placed in the C:/RegPlus/LinkPlus/Report folder.  

10. Close out of Notepad to return to the manual review screen.

11. Click on the Manual Review menu item, and select the Close View option.
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Result:  The main Link Plus window opens.
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Congratulations!
You have successfully completed today’s 
Link Plus linkage exercises.
We will now move on to the Open Discussion portion of the training.
Obtaining Updated Version of Link Plus
Please remember: You have been provided a beta version of the Link Plus software for today’s training.  You will receive notification by e-mail when the new version of Link Plus has been released. 

To obtain the new release of Link Plus when it is available:

1. Go to NPCR Home Page:
http://www.cdc.gov/cancer/npcr
2. In the ‘Tools’ Section

· click on Registry Plus

3. Under ‘Registry Plus Components’

· click on Link Plus 

4. Under ‘On this page’

· click on Installing and Upgrading Link Plus  [image: image179.png]kplus\VbDemo\report\workingview. default]

LI =EIRRS
1 = true matches lse matches [] = uncertain matches = unmatched values = missing values,
Score |Class |Linkage ID | Set ID = |Record # | Patient ID Number |Name-First _|Name-Last _|Name-Middle |Race 1 |Sex |Birth Date| a
1 461 99098 90000600 BENTO  DEVRES W 02 1 13080601 El
[ 330 6 1 461 99180 90000682 BENTO  DEVRES W 02 1 19080601
2 460 99027 90000529 GINA MCELROYS ~ KEYS 02 2 19190410
[ 330 5 2 460 99129 90000631 GINA MCELROYS  KEYS 02 2 19190410
3 459 99043 90000550 JAMARCUS RUDACILLE ~ Z ©2 1 e
[ 328 6 3 459 99148 90000650 JAMARCUS RUDACILLE ~ Z ©2 1 e
4 458 99029 90000531 DARRON ~ DOWDELL ~ NOLAND 02 1 19520425
o327 5 4 458 99131 90000633 DARRON  DOWDELL  NOLAND 02 1 19520425
5 457 99043 90000545 MARIA DEARDEN ~ MARIORE 01 2 19260515
L1323 6 5 457 99143 90000645 MARIA DEARDEN ~ MARIORE 01 2 19260515
6 456 99095 90000598 WAYLAND  DOPSON 9 1 19000306
316 5 6 456 99181 90000683 WAYLAND  DOPSON 9 1 19000306
7 455 99095 90000597 JAKOB BUSHONG B o1 en2r
L1316 6 7 455 99174 90000676 JAKOB BUSHONG B o1 wn2r
8 454 99025 90000527 TYRONE ~ WINFREY ~ ETCHINSON 01 1 1927019
315 6 8 45499127 90000629 TYRONE  WINFREY  ETCHINSON 01 1 19270519
9 453 99036 90000538 FORREST  LANKFORD o 1 19780105
L1314 6 9 453 99136 90000638 FORREST  LANKFORD o 1 19780105
10 452 99082 90000584 ESTER HIPP MAGDALENA 01 2 19561005
314 5 10 452 99187 90000689 ESTER HIPP MAGDALENA 01 2 19561005
1 451 99018 90000520 ZELA WHITTINGTON SCHABLE 01 2 13220201
L1313 6 1 451 99120 90000622 ZELA WHITTINGTON SCHABLE 01 2 13220201
12 450 99067 90000569 BEULAH  LANCON T 01 2 19390614
313 5 12 450 99167 90000669 BEULAH  LANCON T 01 2 19390614
13 449 90000875 MELONE ~ PURPLE CHAVIS 0 2 9T
L1312 6 13 449 90000696 MELONE ~ PURPLE  CHAVIS 0 2 9T
i 448 90000572 NELLA SUTTIE EUNICE 01 2 19720509
312 5 1 448 90000672 NELLA SUTTIE EUNICE 01 2 19720509
15 447 90000517 ORAL HAWS NOONKESTEF 01 1 19930306
L1312 6 15 a7 90000619 ORAL HAWS NOONKESTEF 01 1 19930306
% 446 90000543 STACY MAYS BRITTEN 01 2 19630804
[ 311 5 16 445 90000643 STACY MAYS BRITTEN 01 2 19630804
7 415 20000526 NONOVAN  HUTGH 20 1wt
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